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SINUMERIK 
SinuTrain for SINUMERIK Operate 
Training und Programmierung 
Kompaktbedienanleitung 
  

Vorwort 
Willkommen zu SinuTrain for SINUMERIK Operate - Training und Programmierung 
am PC. 

Mit der Schulungssoftware SinuTrain for SINUMERIK Operate lernen Sie die 
Steuerung 840D sl / 828D zu bedienen und zu programmieren. 

SinuTrain for SINUMERIK Operate - Training und Programmierung 

Diese Dokumentation unterstützt Sie Schritt für Schritt bei folgenden Aufgaben: 

● Installation der Trainings-Software von DVD 

● Übertragung der Lizenz 

● Starten des Programms 

● Auswahl der Werkzeugmaschine 

● Starten der Simulation 

An wen wendet sich SinuTrain for SINUMERIK Operate? 

SinuTrain for SINUMERIK Operate ist zur Aus- und Weiterbildung folgender 
Zielgruppen konzipiert: 

● Neueinsteiger, Umsteiger 

● Ausbildungsleiter, Trainer 

● Vertriebsmitarbeiter zur Kundenpräsentation 

● CNC-Programmierer zur Arbeitsvorbereitung 
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Informationen 

Unter dem Link http://www.siemens.com/motioncontrol/docu gibt es Informationen zu 
folgenden Themen: 

● Dokumentation bestellen 
Hier finden Sie die aktuelle Druckschriftenübersicht. 

● Dokumentation downloaden 
Weiterführende Links für den Download von Dateien aus Service & Support. 

● (Online-) Recherche in der Dokumentation 
Informationen zur DOConCD und direkten Zugriff auf die Druckschriften im 
DOConWEB. 

● Dokumentation individuell zusammenstellen 
Der My Documentation Manager bietet Ihnen eine Reihe von Features zur 
Erstellung Ihrer eigenen Maschinendokumentation. 
Siehe auch http://www.siemens.com/mdm 

● Training und FAQs 
Informationen zum Trainingsangebot und zu FAQs (frequently asked questions) 
finden Sie über die Seitennavigation. 

Rechtsgrundlagen 

Diese Software (SinuTrain™) dient zum Erstellen und Simulieren von NC 
Programmen auf einem PC auf Basis der Programmiersprache DIN 66025 sowie der 
Produkte ShopMill, ShopTurn und Sprachbefehle vom Typ Sinumerik™ 828D und 
840D sl. Die mit der Software erstellten Programme dürfen nur dann zur Fertigung 
mit Werkzeugmaschinen eingesetzt werden, wenn die Software (SinuTrain/JobShop) 
auf die Sinumerik angepasst wurde, auf der das erstellte Programm ablaufen soll. 

Die Anpassung muss fachgerecht von autorisiertem Personal, z.B. von Siemens, 
vom Werkzeugmaschinenhersteller oder vom Händler vorgenommen werden; bei der 
Anpassung sind die Vorgaben von Siemens und vom Werkzeugmaschinenhersteller 
zu beachten. Andernfalls kann es zu Fehlfunktionen der Werkzeugmaschine 
kommen.  

Im Übrigen gelten für die Software für Kunden in Deutschland die "Allgemeinen 
Bedingungen zur Überlassung von Software für Automatisierungs- und 
Antriebstechnik an Lizenznehmer mit Sitz in Deutschland" und für Kunden im 
Ausland die "General Licence Conditions for Software Products for Automation and 
Drives for Customers with a Seat or registered Office outside of Germany". 
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Technical Support 

Bei technischen Fragen wenden Sie sich bitte an folgende Hotline: 
 Europa / Afrika 
Telefon +49 0911 895 7222 
Fax +49 0911 895 7223 
0,14 €/Min. aus dem deutschen Festnetz, abweichende Mobilfunkpreise sind 
möglich. 
Internet http://www.siemens.com/automation/support-request 

 

 Amerika 
Telefon +1 423 262 2522 
Fax +1 423 262 2200 
E-Mail mailto:techsupport.sea@siemens.com 

 

 Asien / Pazifik 
Telefon +86 1064 757 575 
Fax +86 1064 747 474 
E-Mail mailto:support.asia.automation@siemens.com 

 
 

Hinweis 
Landesspezifische Telefonnummern für technische Beratung finden Sie im Internet: 
http://www.automation.siemens.com/partner 
 

 

Fragen zur Dokumentation 

Bei Fragen zur Dokumentation (Anregungen, Korrekturen) senden Sie bitte ein Fax 
oder eine E-Mail an folgende Adresse: 
Fax +49 9131- 98 2176 
E-Mail mailto:docu.motioncontrol@siemens.com 

Internetadresse 

http://www.cnc4you.siemens.com 
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1   Einleitung 
Die Schulungssoftware SinuTrain for SINUMERIK Operate (im folgenden SinuTrain 
genannt) simuliert auf Ihrem PC eine SINUMERIK 840D sl oder SINUMERIK 828D 
mit der Bedienoberfläche SINUMERIK Operate.  
 

Hinweis 
Lizenz 
Für die Verwendung der Maschinen in SinuTrain benötigen Sie eine Lizenz 
 

Originalgetreue Darstellung und Verhalten 

SinuTrain ermöglicht durch die originalgetreue Darstellung von Bedientafelfront, 
Maschinensteuertafel und Bedienoberfläche eine reale Bedienung. 

● SinuTrain beinhaltet eine Maschinensteuertafel mit spezifischen Funktionen einer 
realen Steuertafel (z. B. CYCLE START, Betriebsart etc.). 

● SinuTrain beinhaltet eine Bedientafel, mit der alle spezifischen Funktionen einer 
realen Bedientafel genutzt werden (Hotkey etc.). 

● Die Bedienoberfläche entspricht der originalen Oberfläche von SINUMERIK 
Operate. 

● Die Simulation verhält sich identisch zu einer echten Steuerung. 

● Der volle Funktionsumfang von SINUMERIK Operate auf SINUMERIK 840D sl / 
828D steht zur Verfügung. Ausnahmen sind folgende hardwarebedingte und nicht 
zugelassene Funktionen: 
– Antriebsfunktionen 
– V24-Schnittstelle 
– Serieninbetriebnahme 
– Ferndiagnose 
– Safety- und PLC-Funktionalitäten 
– Ctrl-Energy 

● Der Funktionsumfang der SINUMERIK 828D ist zusätzlich um folgende 
Funktionen eingeschränkt: 
– Service Planer 
– Easy Message 
– Easy Extend 
– Ladder Viewer und Ladder add-on 
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Speichern und Drucken von NC-Programmen 

SinuTrain bietet die Möglichkeit, selbst erstellte NC-Programme (G-Code und 
Arbeitsschrittprogramme) zu speichern. 

Darüber hinaus haben Sie die Möglichkeit, ein Programm, das in der 
Bedienoberfläche von SINUMERIK Operate geöffnet ist auszudrucken. 

Add-On "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 

Um die Funktionalität von SinuTrain zu erweitern, wird das Add-On (zusätzliche 
Softwarekomponente) "SinuTrain for SINUMERIK Operate Machine Configuration 
Tool" angeboten, das additiv zum SinuTrain installiert wird.  

Mit dem "SinuTrain for SINUMERIK Operate Machine Configuration Tool" erstellen 
Sie aus einem Inbetriebnahmearchiv einer realen Maschine eine SinuTrain-
Maschine, mit der Sie dann wie an der realen Maschine üben, lernen und 
programmieren können. 

Im Kapitel "Mit Machine Configuration Tool arbeiten" finden Sie Informationen zur 
Installation und Bedienung von "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool". 
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2   SinuTrain for SINUMERIK Operate 

2.1   SinuTrain installieren / deinstallieren 

2.1.1   Systemvoraussetzungen 
Hardware  

Prozessor: 1,5 GHz (SingleCore) 

RAM: 1 GB 

Festplatte: 2 GB 

DVD-Laufwerk: zur Installation über DVD-Datenträger 

Grafikkarte: minimale Auflösung 640x480 Pixel 

USB-Schnittstelle 

Maus, Tastatur 

Betriebssysteme 

● Windows XP (32 Bit Professional, Home Edition) mit Servicepack 3 

● Windows 7 (32 Bit und 64 Bit, nicht unterstützt werden Starter, Web Edition und 
Embedded) 

Software 

Adobe Acrobat Reader® 

2.1.2   Lizenzierung mit Automation License Manager 
Sie benötigen einen gültigen Lizenzschlüssel, um in SinuTrain eine Maschine starten 
zu können. Dieser ist Bestandteil von SinuTrain for SINUMERIK Operate und wird 
auf einem USB-Stick ausgeliefert.  

Für die Bedienung von SinuTrain ist keine Lizenz notwendig. 

Testlizenz 

Beim ersten Setup von SinuTrain wird eine Testlizenz mitinstalliert, die nur einmalig 
aktiviert werden kann und 60 Tage nach Aktivierung abläuft. In diesen 60 Tagen 
steht der volle Funktionsumfang zur Verfügung. 
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Lizenzregeln 

Folgende Lizenzen stehen Ihnen zur Verfügung, mit denen entsprechende 
Maschinen betrieben werden können: 

● SinuTrain for SINUMERIK Operate 
Keine zeitliche und funktionale Nutzungsbeschränkung. 

● SinuTrain for SINUMERIK Operate Upgrade 
Keine zeitliche und funktionale Nutzungsbeschränkung.  
Nutzbar in Verbindung mit einer vorhandenen SinuTrain Lizenz. 

● SinuTrain for SINUMERIK Operate Student 
Keine funktionale Nutzungsbeschränkung. 
Zeitlich begrenzte Lizenz. 

● SinuTrain for SINUMERIK Operate Trial 
Keine funktionale Nutzungsbeschränkung. 
Zeitlich begrenzte Testlizenz. 

Die Lizenzen ermöglichen die Abbildung folgender Maschinenkonfigurationen: 

Ein- oder Mehrkanalmaschinen beliebiger Technologie (Drehen, Fräsen, Universal) 
oder 828D BASIC-Maschinen beliebiger Technologie (Drehen, Fräsen) 

Für alle Lizenzen gilt, dass die Erweiterungstechnologie beliebig einstellbar ist. 
 

Lizenz mit Automation License Manager übertragen  

Voraussetzung: USB-Stick mit der zu übertragenden Lizenz. 

1. Starten Sie den Automation License Manager über die Ikone oder über das 
Startmenü. 
Der Automation License Manager öffnet sich. 

2. Schließen Sie den USB-Stick an. 
Es erscheint eine "Removable Disk" unter "Eigener Rechner". 

3. Markieren Sie den Eintrag "Removable Disk" auf der linken Seite. 
Auf der rechten Seite sehen Sie die auf dem USB-Stick vorhandenen Lizenzen. 

4. Übertragen Sie die Lizenz nun mit Drag&Drop oder über die rechte Maustaste auf 
eine lokale Festplatte. 
- ODER - 
Wählen Sie im Kontextmenü "Übertragen...". 

5. Wählen Sie in dem sich öffnenden Fenster das Ziel der Lizenzübertragung. 
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Nachdem die Lizenz übertragen ist, erscheint diese auf dem Ziellaufwerk. 
 

Hinweis 
Die Testlizenz erscheint im Automation License Manager erst, nachdem sie aktiviert 
wurde.  
 

2.1.3   SinuTrain installieren 

Voraussetzung 

Für das Starten und Arbeiten mit angelegten Maschinen benötigen Sie einen 
Lizenzschlüssel. Dieser muss vor dem ersten Start einer Maschine auf den PC 
übertragen werden. Zu diesem Zweck wird bei der Installation von SinuTrain ein 
zusätzliches Programm installiert – der Automation License Manager. Mit Hilfe des 
Automation License Manager wird der Lizenzschlüssel auf den PC übertragen.  
 

Hinweis 
Solange keine gültige Lizenz vorhanden ist, können Sie keine Maschine starten. 
 

Das Softwareprodukt SinuTrain for SINUMERIK Operate besteht aus verschiedenen 
Softwarekomponenten, die teilweise ein eigenes Setup besitzen (z. B. Automation 
License Manager).  

Rahmen-Setup 

In einem Rahmen-Setup werden zunächst der Automation License Manager und 
SinuTrain installiert. Anschließend wird optional der CAD-Reader installiert. 

Vorgehensweise 

1. Doppelklicken Sie auf die setup.exe im Wurzelverzeichnis der DVD. 
Unter Windows 7 wird bei aktivierter Benutzerkontensteuerung nach einem 
Doppelklick auf die setup.exe zunächst eine Systemabfrage kommen. Mit dieser 
Abfrage stimmen Sie zu, dass das Setup Änderungen an Ihrem System 
vornehmen darf, diese Abfrage stammt jedoch aus Windows und ist kein von 
Siemens erstellter Bestandteil. Bestätigen Sie diesen Dialog und fahren Sie wie in 
den folgenden Punkten beschrieben mit der Installation fort. 

2. Wählen Sie die Setup-Sprache und klicken Sie auf die Schaltfläche "Weiter >". 

3. Lesen Sie die Hinweise und klicken Sie auf die Schaltfläche "Weiter >". 

4. Lesen Sie die Produkthinweise und klicken Sie auf die Schaltfläche "Liesmich". 

5. Lesen Sie das sich öffnende Readme, schließen Sie es anschließend und klicken 
Sie auf die Schaltfläche "Weiter >". 
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6. Wählen Sie die Sprachen aus, in der Sie SinuTrain for SINUMERIK Operate 
installieren wollen. 
Die ausgewählten Sprachen stehen Ihnen in SinuTrain sowie SINUMERIK 
Operate zur Verfügung. 

7. Akzeptieren Sie die Bedingungen der Lizenzvereinbarung sowie der Security-
Hinweise, indem sie das Kontrollkästchen aktivieren und klicken Sie auf die 
Schaltfläche "Weiter >". 

8. Aktivieren Sie im Fenster "Programme" jeweils die Kontrollkästchen und klicken 
Sie auf die Schaltfläche "Weiter>". 
Wenn Sie den Installationspfad der einzelnen Produkte ändern wollen, markieren 
Sie das jeweilige Produkt, klicken Sie auf die Schaltfläche "Durchsuchen" und 
wählen Sie im folgenden Fenster den gewünschten Ordner. 

 
 Hinweis 

Vor der Installation von SinuTrain wird unter Umständen eine automatische 
Installation von Systemaktualisierungen durchgeführt, die eventuell einen 
Neustart des Rechners notwendig machen. Das Setup wird nach dem Neustart 
des PC anschließend automatisch fortgesetzt. 

 

9. Die Installation von SinuTrain und Automation License Manager beginnt. 
Ist die Installation von SinuTrain beendet, erhalten Sie eine Information sowie 
eine Abfrage, ob der Computer neu gestartet werden soll oder nicht. 

10. Aktivieren Sie die Option "Ja, Computer jetzt neu starten", wenn der Computer 
neu gestartet werden soll und klicken Sie auf die Schaltfläche "Beenden". 
Der Computer wird neu gestartet. Anschließend ist die Installation 
abgeschlossen. SinuTrain und Automation License Manager sind betriebsbereit. 

 

Hinweis 
Benutzerkontensteuerung bei Windows 7 
Sollte bei der Abfrage der Benutzerkontensteuerung als Herausgeber "Unbekannt" 
stehen und der obere Bereich des Dialoges nicht in einem dunklen Blau-Grün, 
sondern einem Orange-Gelb erscheinen, verneinen Sie die Abfrage und melden sich 
bitte bei der Hotline. Alle für Windows 7 freigegebenen Produkte von Siemens sind 
mit einem Zertifikat versehen, wodurch bei der Abfrage als Herausgeber stets die 
Siemens AG angegeben sein wird. 
 

Hinweis 
Klicken Sie auf die Schaltfläche "Abbrechen", um die Installation wieder zu verlassen. 
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Hinweis 
Es wird empfohlen, die Installation nicht aus einem Netzlaufwerk heraus zu starten, 
da es wegen eventuell erforderlichen Systemaktualisierungen zu Problemen 
kommen kann. 
 

2.1.4   SinuTrain deinstallieren 
Wird das Produkt SinuTrain for SINUMERIK Operate deinstalliert, wird SinuTrain for 
SINUMERIK Operate Machine Configuration Tool gleichzeitig deinstalliert. 

Vorgehensweise 

1. Wählen Sie im Windows-Menü Start > Einstellungen > Systemsteuerung.  

2. Doppelklicken Sie in der Liste der Systemsteuerung auf "Software" (Windows XP) 
bzw. "Programme und Funktionen" (Windows 7). 
Die Schaltfläche "Programme ändern oder entfernen" ist aktiv. 

3. Wählen Sie in der Software-Liste "SinuTrain for SINUMERIK Operate 4.5" und 
klicken Sie auf die Schaltfläche "Entfernen". 
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2.2   SinuTrain bedienen 

2.2.1   So funktioniert SinuTrain 

Voraussetzung 

SinuTrain for SINUMERIK Operate ist installiert.  

Allgemeiner Ablauf 

 
●  SinuTrain starten 

Die Maschinenliste von SinuTrain öffnet sich. 

●  Maschine anlegen 
In der Maschinenliste legen Sie eine Maschine an. 
Dabei wählen Sie zunächst über Vorlagen eine Maschine der 
gewünschten Ausprägung (Drehen, Fräsen, Universal). 
Anschließend legen Sie Bezeichnung, Sprache und Auflösung der 
SINUMERIK Operate Bedienoberfläche fest. 

●  Maschine starten 
Die Maschinensimulation öffnet sich mit Bedientafel und 
Bedienoberfläche SINUMERIK Operate, Maschinensteuertafel mit 
Vorschub- und Spindeloverride und CNC-Tastatur. 

 ●  Maschine simulieren 
Die simulierte Maschine können Sie jetzt wie eine echte Maschine 
bedienen und z. B. Programme erstellen. 
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2.2.2   Maschinenliste 
In der Maschinenliste legen Sie Maschinen an, parametrieren und verwalten die 
Maschinenkonfigurationen, mit denen Sie trainieren.     

 
1 SinuTrain-Menü  
2 Funktionsleiste mit Symbolen für wichtige Funktionen 
3 Es werden alle angelegten Maschinen angezeigt 
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 In der Liste erhalten Sie folgende Informationen: 
● Maschine 

Maschinenname, den Sie bei der Konfiguration in Schritt "Einstellungen" 
unter "Allgemein" vergeben. 

● Beschreibung 
Kurzbeschreibung der Maschine, die Sie bei der Konfiguration in Schritt 
"Einstellungen" unter "Allgemein" eingeben. 

● Technologie 
Zeigt die Ausprägung der Maschine an, je nach gewählter 
Standardkonfiguration: 
– 840D sl: Universal 
– 840D sl: Drehen 
– 840D sl: Fräsen 
– 828D: Drehen 
– 828D: Fräsen 

● Lizenzverfügbarkeit 
Zeigt den Lizenzierungszustand der Maschine an. Folgende 
Lizenzzustände sind möglich: 
– grüner Haken: es ist eine vollwertige Lizenz vorhanden 
– rotes X: es ist keine gültige Lizenz vorhanden 
– gelbe Uhr: es ist eine gültige Testlizenz vorhanden 
– schwarzer Strich: der Lizenzstatus ist unbekannt 

● Zuletzt verwendet 
Gibt den Zeitpunkt an, an dem die Maschine das letzte Mal 
heruntergefahren wurde.  

● Erstellt am 
Gibt den Zeitpunkt an, an dem die Maschinenkonfiguration angelegt 
wurde. 

 

Siehe auch 

Menübefehle (Seite 40) 

Symbolübersicht für SinuTrain (Seite 45) 

Statussymbole für SinuTrain-Lizenzen (Seite 46) 
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2.2.3   Bildschirmeinteilung der Maschinensimulation 

Bedienoberfläche von SinuTrain   

 
1 SinuTrain-Menü  
2 Bedienoberfläche SINUMERIK Operate 
3 Bedienelemente einer Bedientafel 
4 Maschinensteuertafel mit Vorschub- und Spindeloverride 
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2.2.4   SinuTrain-Sprache ändern 
Sie haben die Möglichkeit, die Sprache (Deutsch, Englisch, Französisch, Spanisch, 
Italienisch, Chinesisch vereinfacht) der Bedienoberfläche von SinuTrain 
umzuschalten. 

Alle beim Setup oder nachträglich über das Language Update Tool zusätzlich 
installierten Sprachen lassen sich auswählen. 

Vorgehensweise 
 ● Wählen Sie den Menübefehl Extras > Optionen > Sprache. 

 
 

Hinweis 
Sprache von SINUMERIK Operate ändern 
In SINUMERIK Operate ändern Sie über die Tastenkombination <CTRL + L> oder im 
Bedienbereich "Inbetriebnahme" mit Hilfe des Softkeys "Change language" die 
Sprache der Bedienoberfläche von SINUMERIK Operate.  
 

Siehe auch 

Zusätzliche Sprachen für SINUMERIK Operate installieren (Seite 16) 

2.2.5   Bildschirmansicht ändern 
Wählen Sie zwischen Vollbild und Fensteransicht.   

Fensteransicht 

Sie haben die Möglichkeit, das SinuTrain-Fenster zu verschieben, zu minimieren 
bzw. zu maximieren und wiederherzustellen. 

Ist die Bildschirmgröße für die Darstellung der Komponenten nicht groß genug, 
werden eine untere und ggf. eine seitliche Bildlaufleiste (Scrollbalken) eingeblendet. 

Vollbild 

Auf dem Bildschirm ist ausschließlich SinuTrain for SINUMERIK Operate sichtbar.  

Vorgehensweise 
 ● Wählen Sie den Menübefehl Ansicht > Vollbild. 
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2.2.6   Zusätzliche Sprachen für SINUMERIK Operate 
installieren 

Sie haben die Möglichkeit, weitere Sprachen, z.B. fehlende Standardsprachen oder 
Sondersprachen für die SINUMERIK Operate Bedienoberfläche zu installieren. 

Standardsprachen für SINUMERIK Operate installieren 

Installieren Sie eine Standardsprache (Englisch, Französisch, Italienisch, Spanisch, 
Chinesisch vereinfacht), wird auch die SinuTrain-Sprache mit installiert. Ihnen steht 
damit die Online-Hilfe für SinuTrain for SINUMERIK Operate sowie die ergänzenden 
Dokumentationen in der jeweiligen Sprache zur Verfügung. 

Zusätzliche Sprachpakete 

Zusätzliche Sprachpakete werden auf der nachfolgenden Internetadresse zum 
Download angeboten: 

http://www.cnc4you.siemens.com 

Vorgehensweise 
 1. Wählen Sie den Menübefehl Extras > Language Update Tool. 

Das Fenster "Language Update Tool" öffnet sich. 
 2. Klicken Sie auf die Schaltfläche "...", um den Pfad zur Ablage der 

Sprachpakete zu öffnen. 
 3. Wählen Sie die gewünschte Sprachdatei (*.slf) und klicken Sie auf 

die Schaltfläche "Öffnen". 
Sie kehren ins Fenster "Language Update Tool" zurück.  
Der Ablagepfad ist eingetragen und die gewählte Sprache wird 
angezeigt und mit einem Flaggensymbol gekennzeichnet. 
Außerdem wird der Software-Stand des SINUMERIK Operate 
Sprachpakets angezeigt. 

 4. Klicken Sie auf die Schaltfläche "Installieren". 
Eine Fortschrittsanzeige zeigt den Installationsvorgang an.  
Nach erfolgreicher Installation erhalten Sie eine Meldung. 

 5. Klicken Sie auf die Schaltfläche "OK", um die Installation fertig zu 
stellen. 
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Hinweis 
Sie haben die Möglichkeit, den Hinweis zur erfolgreichen Installation für zukünftige 
Installationen von Sprachpaketen auszuschalten. Aktivieren Sie hierfür das 
Kontrollkästchen "Diesen Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Hinweise schalten Sie diesen Hinweis 
für zukünftige Installationen wieder ein.  
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2.3   Mit SinuTrain arbeiten 

2.3.1   SinuTrain starten und beenden 
  
SinuTrain starten 
 1. Wählen Sie den Menübefehl Programme > SinuTrain for 

SINUMERIK Operate 4.5 > SinuTrain. 
  - ODER - 

 
 Doppelklicken Sie auf das Symbol für SinuTrain auf Ihrem 

Desktop. 

 2. Wählen Sie die Sprache aus, in der Sie SinuTrain for SINUMERIK 
Operate öffnen wollen. 
Hinweis: Dieses Auswahlfenster erscheint nur beim ersten Start 
von SinuTrain. 

  SinuTrain for SINUMERIK Operate öffnet sich und zeigt einen 
Nutzungshinweis. 

 3. Klicken Sie auf die Schaltfläche "Start". 
Die SinuTrain - Maschinenliste öffnet sich. 

 
 

Hinweis 
Sie haben die Möglichkeit, den Nutzungshinweis für den zukünftigen Start von 
SinuTrain auszuschalten. Aktivieren Sie hierfür das Kontrollkästchen "Diesen 
Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Hinweise schalten Sie diesen Hinweis 
für zukünftiges Starten des Programms wieder ein 
 
 

SinuTrain beenden 
  Wählen Sie den Menübefehl Datei > Beenden. 

SinuTrain schließt sich. 
Hinweis 
Schließen Sie SinuTrain bei laufender Maschine, wird diese 
geregelt heruntergefahren. 
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2.3.2   Maschine starten und herunterfahren 

Voraussetzung 

In der Maschinenliste stehen Maschinenkonfigurationen zur Verfügung. 

Maschine starten 
  Die SinuTrain-Maschinenliste ist geöffnet. 
 1. Wählen Sie in der Auswahlliste die gewünschte Maschine. 

 

2. Klicken Sie in der Funktionsleiste auf das Symbol "Starten". 
- ODER - 

  Wählen Sie den Menübefehl Maschine > Starten. 
Die Maschinensimulation mit Bedientafel und Bedienoberfläche 
SINUMERIK Operate, Maschinensteuertafel mit Vorschub- und 
Spindeloverride und CNC-Tastatur öffnet sich. 

 3. Sie bedienen SINUMERIK Operate mit Hilfe der Maus oder einer 
Standard-Tastatur. 

 

4. Klicken Sie bei der Bedienung von SINUMERIK Operate auf die 
Taste <HELP> oder drücken Sie die Taste <F12>, um sich die 
kontextsensitive Online-Hilfe für die Fenster und Eingabemasken 
von SINUMERIK Operate anzeigen zu lassen. 
  

Maschine herunterfahren 
  Wählen Sie den Menübefehl Maschine > Herunterfahren, wenn 

Sie die aktuelle Maschinenkonfiguration verlassen wollen.  
Sie kehren in die SinuTrain-Maschinenliste zurück. 

Maschine neu starten 
  Wählen Sie den Menübefehl Maschine > Neu starten, wenn Sie 

die aktuelle Maschinenkonfiguration zum Beispiel nach 
Änderungen von Maschinendaten neu starten wollen.  
Die Maschine fährt herunter und wird anschließend sofort wieder 
hochgefahren. 
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2.3.3   Maschine anlegen 
Ein Assistent erleichtert Ihnen die Erstellung der gewünschten Maschine.   

Sie sehen anhand der Symbole im Assistenten für die Maschinenkonfiguration auf 
einen Blick den Status der Maschinen-Erstellung.   
Symbol Bedeutung 

 Noch nicht bearbeiteter Arbeitsschritt 

 Aktuell anstehender Arbeitschritt 

 Abgeschlossener Arbeitsschritt 

 

Maschinenkonfiguration 

Sie haben folgende Möglichkeiten, eine Maschine anzulegen: 

● Neue Maschine aus einer Vorlage 
Grundlage sind mitgelieferte Standardkonfigurationen für Dreh- und 
Fräsmaschinen. 

● Neue Maschine aus bereits vorhandener Maschinenkonfiguration 
Grundlage ist eine von Ihnen zuvor angelegte Maschinenkonfiguration, welche in 
der SinuTrain-Maschinenliste bereits vorhanden ist. 

● Neue Maschine aus einer importierten Maschinenkonfiguration 
Grundlage ist eine exportierte Maschinenkonfiguration, die Sie importieren und 
modifizieren. 

 

Maschine aus einer Standardkonfiguration anlegen 

 

1. Klicken Sie auf das Symbol "Neu". 

  - ODER - 
  Wählen Sie den Menübefehl Datei > Neu.... 
  Der Dialog "Assistent für die Maschinenkonfiguration" öffnet sich 

zur Aufgabenauswahl.  
Das Optionsfeld "Neue Maschinenkonfiguration aus einer Vorlage 
erstellen" ist aktiviert. 
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 2.  Klicken Sie auf die Schaltfläche "Weiter >". 
 3. Wählen Sie im "Assistent für die Maschinenkonfiguration" im Feld 

"Maschinenauswahl" die gewünschte Ausprägung der Maschine 
(z.B. Einfache vertikale Fräsmaschine). 

 4. Klicken Sie auf die Schaltfläche "Weiter >". 
 5. Wählen Sie im "Assistent für die Maschinenkonfiguration" die 

gewünschten Einstellungen (Allgemein, Sprache und Auflösung) 
und geben Sie Maschinennamen und evtl. eine Kurzbeschreibung 
ein, legen Sie die Sprache fest und wählen Sie die Auflösung der 
Maschinenoberfläche.  

 6. Klicken Sie auf die Schaltfläche "Fertig stellen". 
Die neu angelegte Maschine wird in die Liste der 
Maschinenkonfigurationen eingefügt. 
 

Maschine aus einer vorhandenen Konfiguration anlegen 

 

1. Klicken Sie auf das Symbol "Neu". 

  - ODER - 
  Wählen Sie den Menübefehl Datei > Neu.... 
 2. Aktivieren Sie im "Assistent für die Maschinenkonfiguration" das 

Optionsfeld "Neue Maschinenkonfiguration von vorhandener 
Maschinenkonfiguration erstellen". 

 3. Klicken Sie auf die Schaltfläche "Weiter >". 
 4. Wählen Sie im "Assistent für die Maschinenkonfiguration" im Feld 

"Maschinenauswahl" die von Ihnen gewünschte Maschine und 
ändern Sie die gewünschten Einstellungen (siehe "Maschine aus 
Standardkonfiguration anlegen" Schritte 4 bis 6). 
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Maschine aus einer importierten Konfiguration anlegen   
  Voraussetzung: Sie haben Maschinenkonfigurationen zur 

Sicherung bzw. als Ausgangspunkt für spätere 
Maschinenkonfigurationen exportiert. 

 

1. Klicken Sie auf das Symbol "Import". 

  - ODER - 
  Wählen Sie den Menüpunkt Datei > Importieren. 
 2. Im "Assistent für die Maschinenkonfiguration" ist das Optionsfeld 

"Importieren einer Maschinenkonfiguration" aktiviert. 
 3. Klicken Sie auf die Schaltfläche "Weiter >". 
 4. Klicken Sie auf die Schaltfläche "...", um den Pfad zur Ablage der 

exportierten Konfigurationen zu öffnen. 
 5. Wählen Sie die gewünschte exportierte 

Maschinenkonfigurationsdatei (*.set) und klicken Sie auf die 
Schaltfläche "Öffnen". 
Sie kehren in den Assistenten zurück. Der Ablagepfad ist 
eingetragen. 

 6. Klicken Sie auf die Schaltfläche "Weiter >" 
 7. Ändern Sie im "Assistent für die Maschinenkonfiguration" die 

gewünschten Einstellungen und stellen Sie die Konfiguration fertig 
(siehe "Maschine aus Standardkonfiguration anlegen" Schritte 5 
und 6). 

Siehe auch 

Maschinenkonfiguration exportieren (Seite 24) 
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2.3.4   Maschine löschen 
Benötigen Sie eine Maschinenkonfiguration nicht mehr, können Sie diese aus der 
Auswahlliste der SinuTrain-Maschinen löschen.   

Vorgehensweise 
 1. Wählen Sie die Maschine, die Sie aus der Auswahlliste entfernen 

wollen. 

 

2. Klicken Sie auf das Symbol "Löschen". 

  - ODER - 
  Wählen Sie den Menübefehl Datei > Löschen. 
 3. Bestätigen Sie den Hinweis auf den möglichen Verlust von Daten 

mit "OK" und klicken Sie im anschließenden Nachfragedialog auf 
die Schaltfläche "Ja", um die Maschine zu löschen. 

 
 

Hinweis 
SinuTrain-Maschine mit Anwenderdaten 
Beim Löschen einer Maschine gehen sämtliche Anwenderdaten (z. B. NC-
Programme, Nullpunktverschiebungen etc.) verloren. Die Daten einer gelöschten 
Maschine sind nicht wiederherstellbar.  
 

Hinweis 
Sie haben die Möglichkeit, den Hinweis auf Datenverlust für zukünftige 
Löschvorgänge auszuschalten. Aktivieren Sie hierfür das Kontrollkästchen "Diesen 
Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Hinweise schalten Sie diesen Hinweis 
für zukünftige Löschvorgänge wieder ein. 
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2.3.5   Maschinenkonfiguration exportieren 
Sie haben die Möglichkeit, die von Ihnen konfigurierten Maschinen zu exportieren, 
um sie zu sichern. Die exportierten Maschinenkonfigurationen stehen Ihnen so als 
Ausgangspunkt für spätere Maschinenkonfigurationen oder als Sicherheitskopie zur 
Verfügung. Hierzu importieren Sie dann die gespeicherte 
Maschinenkonfigurationsdatei.  

Exportierte Maschinenkonfigurationen ermöglichen es Ihnen, diese zwischen zwei 
Rechnern auszutauschen oder später in neuere SinuTrain-Versionen zu importieren. 
 

Hinweis 
Die Funktion "Maschinenkonfiguration exportieren" steht für 828D BASIC-Maschinen 
nicht zur Verfügung. 
 

Vorgehensweise 
  Die SinuTrain-Maschinenliste ist geöffnet und Sie haben 

Maschinen nach Ihren Vorstellungen konfiguriert. 

 

1. Klicken Sie auf das Symbol "Export". 

  - ODER - 
  Wählen Sie den Menüpunkt Datei > Exportieren. 
  Der Dialog "Assistent für die Maschinenkonfiguration" öffnet sich 

zur Aufgabenauswahl. Das Optionsfeld "Exportieren einer 
Maschinenkonfiguration" ist aktiviert. 

 2. Klicken Sie auf die Schaltfläche "Weiter >". 
 3. Wählen Sie im "Assistent für die Maschinenkonfiguration" im Feld 

"Maschinenauswahl" die gewünschte Maschine und klicken Sie 
auf die Schaltfläche "Weiter >".  

 4. Klicken Sie im "Assistent für die Maschinenkonfiguration" auf die 
Schaltfläche "...". 
Das Fenster "Speichern unter" öffnet sich. 

 5 Navigieren Sie zum gewünschten Ablageort und klicken Sie auf 
"Speichern". 
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 6. Klicken Sie im Assistenten auf die Schaltfläche "Fertig stellen". 
Eine Fortschrittsanzeige zeigt den Exportvorgang an.  
Nach erfolgreichem Abschluss erhalten Sie eine Meldung. 
Die Maschinenkonfigurationsdatei (*.set) ist abgelegt. Die Datei 
kann nun jederzeit wieder importiert werden. 

 
 

Hinweis 
Sie haben die Möglichkeit, den Hinweis zum erfolgreichen Export für zukünftige 
Maschinenexporte auszuschalten. Aktivieren Sie hierfür das Kontrollkästchen 
"Diesen Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Hinweise schalten Sie diesen Hinweis 
für zukünftige Exportevorgänge wieder ein. 
 

Siehe auch 

Maschine anlegen (Seite 20) 

2.3.6   Maschineneinstellungen ändern 
Sie haben die Möglichkeit, folgende Einstellungen für eine Maschine zu ändern:  

● Allgemein 
– Maschinenname 
– Beschreibung 

● Sprache 

Sprache der Maschinenoberfläche (Deutsch, Englisch, Französisch, Spanisch, 
Italienisch, Chinesisch vereinfacht). Zur Auswahl stehen nur Sprachen zur 
Verfügung, die bei der Installation ausgewählt wurden. 

Haben Sie nachträglich über das Language Update Tool Sondersprachen installiert, 
stehen diese hier ebenfalls zur Auswahl zur Verfügung. 

● Auflösung 
Auflösung der Maschinenoberfläche 
– 640x480 
– 800x600 
– 1024x768 
– 1280x1024 
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 Hinweis 

Für 828D BASIC-Maschinen steht nur die Auflösung 640x480 der 
Maschinenoberfläche zur Verfügung. 

 

Vorgehensweise 
 1. Wählen Sie in der SinuTrain - Maschinenliste die Maschine, für 

die Sie die Einstellungen ändern wollen.  

 

2. Klicken Sie auf das Symbol "Einstellungen". 

  - ODER - 
  Wählen Sie den Menübefehl Maschine > Einstellungen... 
 3. Wählen Sie im linken Auswahlfenster die gewünschte 

Einstellungsoption und geben Sie jeweils den neuen Namen bzw. 
Kurzbeschreibung ein, wählen Sie die gewünschte Sprache 
und/oder legen Sie die Größe der Bedienoberfläche von 
SINUMERIK Operate fest. 

 4. Klicken Sie auf "OK", um Ihre Eingaben zu bestätigen. 

2.3.7   Programm ausdrucken 
Sie haben die Möglichkeit, den Inhalt von Textdateien (wie z. B. NC-Programme) mit 
einem am PC konfigurierten Drucker (lokale Drucker, Netzwerkdrucker) direkt über 
SinuTrain aus der SINUMERIK Operate Bedienoberfläche zu drucken.  

Sie können G-Code Programme sowie ShopMill / ShopTurn Arbeitsschrittprogramm 
mit G-Code drucken. 

Seite einrichten 

Im Fenster "Seite einrichten" können Sie das Layout für den Druck konfigurieren und 
festlegen, in welchem Umfang NC-Programme gedruckt werden.  
 

Hinweis 
Die Funktion "Programm drucken" steht für 828D BASIC-Maschinen nicht zur 
Verfügung. 
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Einstellungen Auswirkung 
 
Links: 

 
Rechts: 

Ränder 
(mm) 

Oben: Unten: 

Hier definieren Sie die Seitenränder des 
Ausdrucks. 
Legt den Abstand zwischen oberem, 
unterem, rechten und linken Seitenrand 
und dem jeweiligen Rand der Zeilen in mm 
fest. 

   
 
 
Alles 

Hier legen Sie den Umfang des 
Programmausdrucks fest. 
Legt fest, dass das ganze NC-Programm 
ausgedruckt wird. 

Zeilen 
Von: bis:  

Legt die Zeilen des NC-Programms fest, 
die ausgedruckt werden. 

Druck- 
bereich 

Ausgewählter Bereich Legt fest, dass der im Editor markierte Teil 
des NC-Programms ausgedruckt wird. 

  
Blöcke aufklappen Legt fest, dass bei Verwendung von 

Programmblöcken, die Programmsätze in 
den Blöcken mit ausgedruckt werden. 

Zyklen als G-Code drucken Legt fest, dass Arbeitsschrittprogramme 
(ShopMill/ShopTurn) als G-Code 
ausgedruckt werden. 

Vorgehensweise 

 

1. Wählen Sie im Ablageverzeichnis des Programm-Managers das 
Programm, das Sie ausdrucken wollen. 

 

2. Positionieren Sie den Cursor auf das Programm und klicken Sie 
auf den Softkey "Öffnen". 
Das Programm öffnet sich im Editor. 

 3. Wählen Sie den Menübefehl Datei > Seite einrichten.  
 4. Geben Sie im Fenster "Seite einrichten" die Abstände für die 

Seitenränder ein, legen Sie den Druckbereich und die 
Darstellungsform des Programms fest und klicken Sie auf die 
Schaltfläche "OK", um Ihre Angaben zu bestätigen. 
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 6. Wählen Sie den Menübefehl Datei > Drucken. 
Der Dialog "Drucken" mit dem aktivierten Standard-Drucker 
(lokale Drucker, Netzwerkdrucker) öffnet sich. 

 7. Klicken Sie auf die Schaltfläche "Drucken". 
Je nach Festlegung des Druckbereichs wird das gesamte 
Programm, eine bestimmte Anzahl von Zeilen des Programms 
oder ein markierter Bereich des Programms ausgedruckt. 
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3   SinuTrain for SINUMERIK Operate 
Machine Configuration Tool 

3.1   Machine Configuration Tool installieren / 
deinstallieren 

3.1.1   Übersicht 
Mit dem SinuTrain for SINUMERIK Operate Machine Configuration Tool erstellen Sie 
aus einem Inbetriebnahmearchiv einer realen Maschine eine SinuTrain-Maschine. 
Damit haben Sie dann die Möglichkeit, an dem Abbild einer real existierenden 
Maschine zu üben, zu lernen und zu programmieren. 

Zusätzlich haben Sie die Möglichkeit, für exportierte SinuTrain for SINUMERIK 
Operate Maschinendateien einen Weitergabeschutz zu parametrieren. 
 

Hinweis 
Die aus dem Inbetriebnahmearchiv übernommene Parametrierungen gelten nur für 
die erstellte Maschinenkonfiguration. 
 

Hinweis 
Lizenzpflicht 
Für den Betrieb des SinuTrain for SINUMERIK Machine Configuraion Tool benötigen 
Sie eine Lizenz. Ohne diese Lizenz kann das Tool nicht gestartet werden. 
 

Lizenz übertragen 

Zusammen mit dem SinuTrain for SINUMERIK Operate Machine Configuration Tool 
erhalten Sie einen USB-Stick mit der zu übertragenden Lizenz. 

Die Übertragung geschieht mit Hilfe des Automation License Manager. 

Siehe auch 

Lizenzierung mit Automation License Manager (Seite 6) 
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3.1.2   Systemvoraussetzungen 
Hardware  

Prozessor: 1,5 GHz (SingleCore) 

RAM: 1 GB 

Festplatte: 2 GB 

DVD-Laufwerk: zur Installation über DVD-Datenträger 

Grafikkarte: minimale Auflösung 640x480 Pixel 

USB-Schnittstelle 

Maus, Tastatur 

Betriebssysteme 

● Windows XP (32 Bit Professional, Home Edition) mit Servicepack 3 

● Windows 7 (32 Bit und 64 Bit, Editionen Starter, Web Edition und Embedded 
werden nicht unterstützt) 

Software 

Adobe Acrobat Reader® 

SinuTrain for SINUMERIK Operate 

3.1.3   Machine Configuration Tool installieren 

Voraussetzungen 

Sie haben SinuTrain for SINUMERIK Operate Machine Configuration Tool erstanden.   

Um SinuTrain for SINUMERIK Operate Machine Configuration Tool zu nutzen, ist die 
Installation von SinuTrain for SINUMERIK Operate erforderlich. 

 
 

Hinweis 
Für eine erfolgreiche Installation, müssen SinuTrain for SINUMERIK Operate und 
SinuTrain for SINUMERIK Operate Machine Configuration Tool die gleiche Version 
haben. 
SinuTrain for SINUMERIK Operate Machine Configuration Tool ist nur installierbar, 
wenn SinuTrain for SINUMERIK Operate nicht gestartet ist. 
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Vorgehensweise 

1. Doppelklicken Sie auf die setup.exe im Wurzelverzeichnis der DVD. 

2. Wählen Sie die Setup-Sprache und klicken Sie auf die Schaltfläche "Weiter >". 

3. Lesen Sie die Hinweise und klicken Sie auf die Schaltfläche "Weiter >". 

4. Lesen Sie die Produkthinweise und klicken Sie auf die Schaltfläche "Liesmich". 

5. Lesen Sie das sich öffnende Readme, schließen Sie es anschließend und klicken 
Sie auf die Schaltfläche "Weiter >". 

6. Akzeptieren Sie die Bedingungen der Lizenzvereinbarung und klicken Sie auf die 
Schaltfläche "Weiter >". 

7. Die Installation von SinuTrain for SINUMERIK Operate Machine Configuration 
Tool beginnt. 

8. Ist die Installation beendet, erhalten Sie eine Information. 

9. Klicken Sie auf die Schaltfläche "Fertig stellen". 

3.1.4   Machine Configuration Tool deinstallieren 
Das SinuTrain for SINUMERIK Operate Machine Configuration Tool ist separat 
deinstallierbar.  
 

Hinweis 
SinuTrain for SINUMERIK Operate Machine Configuration Tool ist nur deinstallierbar, 
wenn SinuTrain for SINUMERIK Operate nicht gestartet ist. 
Wird SinuTrain for SINUMERIK Operate deinstalliert, wird SinuTrain for SINUMERIK 
Operate Machine ConfigurationTool ebenfalls deinstalliert. 
 

Vorgehensweise 

1. Wählen Sie im Windows-Menü Start > Einstellungen > Systemsteuerung. 

2. Doppelklicken Sie in der Liste der Systemsteuerung auf "Software". 

3. Die Schaltfläche "Programme ändern oder entfernen" ist aktiv. 

4. Wählen Sie in der Software-Liste "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool 4.5" und klicken Sie auf die Schaltfläche "Entfernen". 
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3.2   Machine Configuration Tool bedienen 

3.2.1   So funktioniert das Machine Configuration Tool 

Voraussetzung   

SinuTrain for SINUMERIK Operate Machine Configuration Tool ist installiert. 

Allgemeiner Ablauf - Maschinenkonfiguration aus Archivdatei erstellen 

● SinuTrain starten 

● Machine Configuration Tool aufrufen 

● Archivdatei wählen 

● Allgemeine Einstellungen (Bezeichnung, Sprache, Auflösung) vornehmen 

● Weitergabeschutz einstellen 

● Ablageverzeichnis angeben 

Allgemeiner Ablauf - Exportierte Maschinenkonfiguration nachträglich mit 
Weiterschutz versehen 

● SinuTrain starten 

● Machine Configuration Tool aufrufen 

● Exportierte Maschinendatei wählen 

● Kennwort für Maschinenstart festlegen 
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3.3   Mit Machine Configuration Tool arbeiten 

3.3.1   Maschinenkonfiguration erstellen 
Ein Assistent erleichtert Ihnen die Erstellung der gewünschten 
Maschinenkonfiguration.  

Sie sehen anhand der Symbole im Assistenten für die Maschinenkonfiguration auf 
einen Blick den Status der Maschinenkonfiguration. 
Symbol Bedeutung 

 Noch nicht bearbeiteter Arbeitsschritt 

 Aktuell anstehender Arbeitschritt 

 Abgeschlossener Arbeitsschritt 

Voraussetzung 

Ein Inbetriebnahmearchiv (*.arc) oder eine SinuTrain for SINUMERIK Operate 
Maschinendatei (*.set) ist vorhanden. 
 

Hinweis 
Andere Archivformate, wie z.B. Datenklassenarchive (*.ard) werden nicht unterstützt. 
 

Vorgehensweise 

Der Assistent "SinuTrain for SINUMERIK Operate Machine Configuration Tool" mit 
dem Schritt "Aufgabenauswahl" öffnet sich. Das Optionsfeld 
"Maschinenkonfiguration" ist aktiviert. 

1. Wählen Sie Extras > Machine Configuration Tool. 
Der Assistent "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 
mit dem Schritt "Aufgabenauswahl" öffnet sich. 

2. Klicken Sie auf die Schaltfläche "Weiter". 

3. Klicken Sie im Assistent "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" mit dem Schritt "Archivauswahl" auf die Schaltfläche "...". 

4. Wählen Sie im Fenster "Öffnen" über die Auswahlliste "Suchen in" den Ablageort 
der abgelegten Archive, wählen Sie das gewünschte Inbetriebnahmearchiv (*.arc) 
und klicken Sie auf die Schaltfläche "Öffnen". 

5. Wählen Sie anschließend die Hardware-Plattform (z.B. NCU720), auf der das 
Inbetriebnahmearchiv erstellt wurde. 
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6. Klicken Sie auf die Schaltfläche "Weiter". 

7. Geben Sie im Assistent "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" mit dem Schritt "Einstellungen" die gewünschten Angaben zur 
Maschinenkonfiguration (Name und Beschreibung) an, wählen Sie die 
gewünschte Sprache sowie die Auflösung der SINUMERIK Operate 
Bedienoberfläche. 

8. Aktivieren Sie im Assistent "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" mit dem Schritt "Weitergabeschutz" das Kontrollkästchen 
"Maschinenexport unterbinden" und/oder "Kennwort für Maschinenstart 
erforderlich" und geben Sie bei Bedarf ein Kennwort ein. 

9. Klicken Sie auf die Schaltfläche "Weiter". 

10. Klicken Sie im Assistent "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" mit dem Schritt "Ablagepfad" auf die Schaltfläche "...". 

11. Wählen Sie im Fenster "Speichern unter" über die Auswahlliste "Speichern in" 
den Ablageort der neuen Maschinenkonfiguration, geben Sie bei Bedarf einen 
neuen Dateinamen ein und klicken Sie auf die Schaltfläche "Speichern". 

12. Klicken Sie auf die Schaltfläche "Weiter". 
Im Assistent "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 
erhalten Sie eine Zusammenfassung aller wichtigen Einstellungen der zu 
erstellenden Maschinenkonfiguration. 

13. Klicken Sie auf die Schaltfläche "Fertig stellen". 
Sie erhalten eine Meldung, dass die Maschinenkonfiguration erfolgreich erstellt 
wurde.  
Klicken Sie auf die Schaltfläche "OK", um den Vorgang abzuschließen. 

 

Hinweis 
Wenn dieser Hinweis auf die erfolgreiche Erstellung der Maschinenkonfiguration in 
Zukunft nicht mehr angezeigt werden soll, aktivieren Sie das Kontrollkästchen 
"Diesen Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Configuration Tool schalten Sie diesen 
Hinweis für zukünftige Maschinenkonfigurationen wieder ein. 
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3.3.2   Exportierte Maschine mit Weitergabeschutz versehen 
Sie haben die Möglichkeit, exportierte Maschinen nachträglich mit einem 
Weitergabeschutz zu versehen.  

Um eine mit Weitergabeschutz versehene Maschine in der Maschinenliste zu starten, 
müssen Sie das benötigte Kennwort eingeben. 
 

Hinweis 
Exportierte Maschinendateien, die mit einer Vorgängerversion von SinuTrain for 
SINUMERIK Operate erstellt wurden, können nicht mit einem Weitergabeschutz 
versehen werden. 
 

Voraussetzung 

Eine SinuTrain for SINUMERIK Operate Maschinendatei (*.set) ist vorhanden. 

Vorgehensweise 
 1. Wählen Sie Extras > Machine Configuration Tool. 

Der Assistent "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" mit dem Schritt "Aufgabenauswahl" öffnet 
sich. 

 2. Aktivieren Sie die Option "Weitergabeschutz hinzufügen" und 
klicken Sie auf die Schaltfläche "Weiter". 

 3. Klicken Sie im Assistent "SinuTrain for SINUMERIK Operate 
Machine Configuration Tool" mit dem Schritt "Maschinenauswahl" 
auf die Schaltfläche "...". 

 4. Wählen Sie im Fenster "Öffnen" über die Auswahlliste "Suchen in" 
den Ablageort der exportierten Maschinen, wählen Sie die 
gewünschte Maschinendatei (*.set) und klicken Sie auf die 
Schaltfläche "Öffnen". 

 5. Klicken Sie auf die Schaltfläche "Weiter". 
 6. Aktivieren Sie im Assistent "SinuTrain for SINUMERIK Operate 

Machine Configuration Tool" mit dem Schritt "Weitergabeschutz" 
das Kontrollkästchen "Kennwort für Maschinenstart erforderlich". 
Die Eingabefelder "Kennwort" und "Kennwortwiederholung" 
werden editierbar. 

 7. Geben Sie das gewünschte Kennwort in beide Felder ein und 
klicken Sie auf die Schaltfläche "Fertig stellen". 
Sie erhalten eine Meldung, dass der Weitergabeschutz erfolgreich 
eingestellt ist. 
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 8. Klicken Sie auf die Schaltfläche "OK", um den Vorgang 
abzuschließen. 

 
 

Hinweis 
Wenn der Hinweis auf die erfolgreiche Erstellung eines Weitergabeschutzes in 
Zukunft nicht mehr angezeigt werden soll, aktivieren Sie das Kontrollkästchen 
"Diesen Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Configuration Tool schalten Sie diesen 
Hinweis für zukünftige Einstellungen eines Weitergabeschutzes wieder ein. 
 

3.3.3   Weitergabeschutz entfernen 
Sie haben die Möglichkeit, einen Weitergabeschutz teilweise zurückzunehmen  
 

Hinweis 
Startkennwort 
Ein vergebenes Startkennwort kann nicht nachträglich geändert werden. 
 

Voraussetzung 

Eine SinuTrain for SINUMERIK Operate Maschinendatei (*.set) ist mit einem 
Weitergabeschutz versehen. 

Vorgehensweise 
 1. Wählen Sie Extras > Machine Configuration Tool. 

Der Assistent "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" mit dem Schritt "Aufgabenauswahl" öffnet 
sich. 

 2. Aktivieren Sie die Option "Weitergabeschutz bearbeiten" und 
klicken Sie auf die Schaltfläche "Weiter". 

 3. Klicken Sie im Assistent "SinuTrain for SINUMERIK Operate 
Machine Configuration Tool" mit dem Schritt "Maschinenauswahl" 
auf die Schaltfläche "...". 

 4. Wählen Sie im Fenster "Öffnen" über die Auswahlliste "Suchen in" 
den Ablageort der exportierten Maschinen, wählen Sie die 
gewünschte Maschinendatei (*.set) und klicken Sie auf die 
Schaltfläche "Öffnen". 

 5. Klicken Sie auf die Schaltfläche "Weiter". 
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 6. Deaktivieren Sie im Assistent "SinuTrain for SINUMERIK Operate 
Machine Configuration Tool" mit dem Schritt "Weitergabeschutz" 
das Kontrollkästchen "Maschinenexport unterbinden". 

 7. Klicken Sie auf die Schaltfläche "Fertig stellen". 
Sie erhalten eine Meldung, dass der Weitergabeschutz erfolgreich 
aufgehoben ist. 

 8. Klicken Sie auf die Schaltfläche "OK", um den Vorgang 
abzuschließen. 

 
 

Hinweis 
Wenn der Hinweis auf die erfolgreiche Erstellung eines Weitergabeschutzes in 
Zukunft nicht mehr angezeigt werden soll, aktivieren Sie das Kontrollkästchen 
"Diesen Hinweis nicht wieder anzeigen". 
Über den Menübefehl Extras > Optionen ... > Configuration Tool schalten Sie diesen 
Hinweis für zukünftige Einstellungen eines Weitergabeschutzes wieder ein. 
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4   Ergänzende Dokumentationen 

4.1   Bedienhandbücher und Trainingsanleitungen 
Bei der Bedienung in SinuTrain haben Sie die Möglichkeit, die kontextsensitive 
Online-Hilfe von SINUMERIK Operate über die HELP-Taste zu verwenden.  

Zusätzlich stehen ergänzende und weiterführende Bedienhandbücher und 
Trainingsunterlagen in sechs Sprachen (Deutsch, Englisch, Französisch, Italienisch, 
Spanisch, Chinesisch vereinfacht) zur Verfügung. 
 

Hinweis 
Ist eine fremdsprachige Version eines Dokumentes nicht verfügbar, steht Ihnen 
alternativ die englische Ausgabe zur Verfügung. 
 

Bedienanleitungen und Trainingsunterlagen 

● Einfacher Fräsen mit ShopMill 
– Grundlagen zu Fräsen 
– Handhabung des Programms 
– Schritt-für-Schritt-Anleitungen zur Programmierung und Bearbeitung 

verschiedener Beispiele 

● Einfacher Drehen mit ShopTurn 
– Grundlagen zu Drehen 
– Handhabung des Programms 
– Schritt-für-Schritt-Anleitungen zur Programmierung und Bearbeitung 

verschiedener Beispiele 

● Fräsen 
– Ausführliches Bedienhandbuch für SINUMERIK Operate auf SINUMERIK 

840D sl/828D mit der Ausprägung Fräsen. 

● Drehen 
– Ausführliches Bedienhandbuch für SINUMERIK Operate auf SINUMERIK 

840D sl/828D mit der Ausprägung Drehen. 

● Universal 
– Ausführliches Bedienhandbuch für SINUMERIK Operate auf SINUMERIK 

840D sl mit der Ausprägung Universal (ohne Zyklenbeschreibungen). 

● Grundfunktionen 
– Ausführliches Funktionshandbuch mit Beschreibung von SINUMERIK 

Grundfunktionen. 
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● G-Code-Programmierung 
– Ausführliches Programmierhandbuch mit Beschreibung sämtlicher Parameter. 

● Programmierhandbuch Grundlagen 
– Programmierhandbuch für Anwender mit Grundkenntnissen in Bohr-, Fräs- 

und Drehbearbeitungen. 
– Einfache Programmierbeispiele, die auch nach DIN 66025 bekannte Befehle 

und Anweisungen erläutert. 

● Funktionshandbuch ISO Dialekte 
– Beschreibung für die Inbetriebnahme und Abarbeitungsmöglichkeit von 

Teileprogrammen externer CNC-Systeme. 

● Programmierhandbuch ISO Fräsen 
– Ausführliche Beschreibung der Besonderheiten der Programmierung im ISO-

Mode für die Ausprägung Fräsen. 
Programmierhandbuch ISO Drehen 
– Ausführliche Beschreibung der Besonderheiten der Programmierung im ISO-

Mode für die Ausprägung Drehen 

● CAD Reader 
– Handhabung des Programms 
– Anleitung anhand eines Anwendungsbeispiels 
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A Anhang 

A.1 Menübefehle 
Zur Bedienung von SinuTrain stehen folgende Menübefehle zur Verfügung:  

 
 
Menü Menübefehle Funktion 

Neu... Startet den Assistent für die 
Maschinenkonfiguration. 

Löschen Löscht eine ausgewählte 
SinuTrain-Maschine. 

Importieren… Öffnet den "Assistent für die 
Maschinenkonfiguration", um 
abgelegte und gesicherte 
Maschinen in die SinuTrain-
Maschinenliste aufzunehmen. 

Datei 

Exportieren… Öffnet den "Assistent für die 
Maschinenkonfiguration", um 
Maschinenkonfigurationen aus der 
SinuTrain-Maschinenliste zu 
exportieren. 

 Seite einrichten... Öffnet das Fenster "Seite 
einrichten". 
Hier legen Sie Seitenränder und 
Druckbereich fest und wählen die 
Darstellungsform der NC-
Programme. 

 Drucken  Druckt Programme entsprechend 
der Festlegungen in "Seite 
einrichten" aus dem Editor des 
SINUMERIK Operate.  

 Beenden Beendet SinuTrain for SINUMERIK 
Operate. 
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Menü Menübefehle Funktion 
Ansicht Vollbild  Hier wählen Sie zwischen 

Fensteransicht und 
Vollbilddarstellung. 

Maschine Starten Startet die im Auswahlfeld der 
SinuTrain-Maschinenliste gewählte 
Maschinenkonfiguration. 

 Neu starten Die SinuTrain-Maschine wird 
heruntergefahren und anschließend 
wieder automatisch gestartet. 

 Herunterfahren Fährt die SinuTrain-Maschine 
herunter.  
Die SinuTrain-Maschinenliste bleibt 
geöffnet. 

 Einstellungen… Öffnet das Fenster "Einstellungen", 
in dem Sie Sprache und Auflösung 
der SINUMERIK Operate 
Oberfläche einstellen. 

 Lizenzverfügbarkeit prüfen Prüft, ob für die ausgewählte 
SinuTrain-Maschine eine 
ausreichende Lizenz vorhanden ist. 

 Lizenzinformationen… Zeigt an, welche Lizenzen für die 
ausgewählte Maschine verwendet 
werden können. 

Extras Language Update Tool Ruft das Language Update Tool 
auf. 
 

 Machine Configuration Tool Ruft das SinuTrain for SINUMERIK 
Operate Machine Configuration 
Tool auf. 
Der Menüeintrag ist nur vorhanden, 
wenn das Add-on SinuTrain for 
SINUMERIK Operate Machine 
Configuration Tool installiert ist. 

 Lizenzverfügbarkeiten prüfen Prüft die Lizenzverfügbarkeit für 
alle in der Maschinenliste 
verfügbaren 
Maschinenkonfigurationen. 
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Menü Menübefehle Funktion 
Sprache Hier haben Sie die Möglichkeit, die 

Sprache der SinuTrain-Oberfläche 
zu ändern. 

 Optionen... 

Hinweise Aktiviert bzw. deaktiviert 
Hinweismeldungen in SinuTrain for 
SINUMERIK Operate (z.B. Hinweis 
auf möglichen Datenverlust beim 
Löschen einer SinuTrain-
Maschine). 
 

Hilfethemen Öffnet die Online-Hilfe für SinuTrain 
for SINUMERIK Operate. 

Hilfe 

Werkzeuge Machine 
Configuration 
Tool 

Öffnet die Online-Hilfe für SinuTrain 
for SINUMERIK Operate Machine 
Configuration Tool.  
Der Menüeintrag ist nur vorhanden, 
wenn das SinuTrain for 
SINUMERIK Operate Machine 
Configuration Tool installiert ist. 
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Menü Menübefehle Funktion 
Info... Öffnet das Informationsfenster 

"Über SinuTrain for SINUMERIK 
Operate". 
Hier erfahren Sie die 
Produktversion des installierten 
SinuTrain for SINUMERIK Operate. 
Der Bereich "Installierte 
Werkzeuge" enthält die Versionen 
aller installierten Add-On-
Komponenten (z.B. SinuTrain for 
SINUMERIK Operate Machine 
Configuraion Tool). 
Die Schaltfläche "Erweitert..." öffnet 
einen Dialog mit einer Übersicht 
aller installierten 
Komponentenversionen. 
Über die Schaltfläche "Kopieren" 
besteht die Möglichkeit, alle 
Versionsinformationen in die 
Zwischenablage zu kopieren, um 
sie beispielweise in eine Mail bei 
der Klärung eines Problemfalls 
einzufügen.  
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A.2 Kontextmenü 
In der Maschinenliste steht Ihnen ein Kontextmenü mit folgenden Befehlen zur 
Verfügung: 
Menübefehle  Funktion 
Starten Startet die im Auswahlfeld der SinuTrain-Maschinenliste 

gewählte Maschinenkonfiguration. 
Exportieren… Öffnet den "Assistent für die Maschinenkonfiguration", um 

Maschinenkonfigurationen aus der SinuTrain-
Maschinenliste zu exportieren. 

Löschen Löscht eine ausgewählte SinuTrain-Maschine. 
Einstellungen… Öffnet das Fenster "Einstellungen", in dem Sie Sprache 

und Auflösung der SINUMERIK Operate Oberfläche 
einstellen. 

Lizenzverfügbarkeit 
prüfen 

Prüft, ob für die ausgewählte SinuTrain-Maschine eine 
ausreichende Lizenz vorhanden ist. 

Lizenzinformationen… Zeigt an, welche Lizenzen für die ausgewählte Maschine 
verwendet werden können. 
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A.3 Symbolübersicht für SinuTrain 
In der Funktionsleiste der Maschinenliste von SinuTrain stehen folgende Symbole 
zur schnellen Anwahl von wichtigen Funktionen zur Verfügung.   
Symbol Bedeutung 

 

Start 
Startet die aus der Liste gewählte Maschine. 

 

Import 
Öffnet das Fenster des Assistenten für die 
Maschinenkonfiguration, mit dem Sie eine bereits angelegte 
Konfiguration importieren. 

 

Export 
Öffnet das Fenster des Assistenten für die 
Maschinenkonfiguration, mit dem Sie eine angelegte 
Konfiguration exportieren. 

 

Neu 
Öffnet den Assistenten für die Maschinenkonfiguration. 

 

Löschen 
Löscht eine gewählte Maschinenkonfiguration. 

 

Einstellungen 
Öffnet das Fenster "Einstellungen", in dem Sie die Einstellungen 
für Sprache und Auflösung der SINUMERIK Operate Oberfläche 
vornehmen. 

 



Anhang 

 Training und Programmierung 
46 6FC5095-0AC50-0YP0, 01/2013 

A.4 Statussymbole für SinuTrain-Lizenzen 
Folgende Symbole geben Auskunft über das Vorhandensein bzw. die Gültigkeit von 
Lizenzen der Maschinen.    
Statussymbol Bedeutung  

 
Gültige Lizenz ist vorhanden 

 
Es ist keine gültige Lizenz vorhanden 

 Es ist eine gültige Testlizenz vorhanden 

 
Status der Lizenz ist nicht bekannt 
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A.5 Bedienung mit PC-Standardtastatur 
Zur Bedienung von SinuTrain SINUMERIK Operate stehen folgende Tasten und 
Tastenkombinationen zur Verfügung.  
PC-Tastatur Funktion 
<F1> ... <F8> Horizontale Softkeys 1 bis 8 
Shift + <F1> ... <F8> Vertikale Softkeys 1 bis 8 
<F9> 

 

Shift + <F9> 

 

<F10> 

 

Shift + <F10> 

 

<F11> 

 

<F12> 

 

<Bild ↑> 

 

<Bild ↓> 

 

<Enter> 

 

<Einfg> 
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PC-Tastatur Funktion 
Ziffernblock <5> 

 

<Esc> 

 

<Strg> + <Alt> + <Shift> + 
<1> 

 

<Strg> + <Alt> + <Shift> + 
<2> 

Die laufende SinuTrain-Maschine wird 
heruntergefahren. 

<Strg> + <Alt> + <Shift> + 
<3> 

 

<Strg> + <Alt> + <Shift> + 
<4> 

 

<Strg> + <Alt> + <Shift> + 
<5> 

 

<Strg> + <Alt> + <Shift> + 
<6> 

 

<Strg> + <Alt> + <Shift> + 
<7> 

 

<Strg> + <Alt> + <Shift> + 
<8> 
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SINUMERIK 
SinuTrain for SINUMERIK Operate 
Training and Programming 
Compact User Manual 
  

Preface 
Welcome to the SinuTrain for SINUMERIK Operate - Training and programming at 
the PC. 

The training software SinuTrain for SINUMERIK Operate teaches you how to operate 
and program the 840D sl control system / 828D. 

SinuTrain for SINUMERIK Operate - Training and programming 

This documentation supports you step-by-step for the following tasks: 

● Installing the training software from DVD 

● Transferring the license 

● Starting the program 

● Selecting the machine tool 

● Starting simulation 

What groups does SinuTrain for SINUMERIK Operate address? 

SinuTrain for SINUMERIK Operate is designed for basic and further training of the 
following target groups: 

● First time users, users changing over from a different system 

● Training managers, trainers 

● Sales personnel for customer presentations 

● CNC programmer for work preparation 
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Information 

Information on the following topics is available at 
http://www.siemens.com/motioncontrol/docu: 

● Ordering documentation 
Here you can find an up-to-date overview of publications. 

● Downloading documentation 
Links to more information for downloading files from Service & Support. 

● (online) research in the documentation 
Information on DOConCD and direct access to the publications in DOConWEB. 

● Compile customized documentation 
My Documentation Manager provides you with a range of features for generating 
your own machine documentation. 
See also http://www.siemens.com/mdm 

● Training and FAQs 
Information on our range of training courses and FAQs (frequently asked 
questions) is available via the page navigation. 

Legal basics 

This software (SinuTrain™) is used to generate and simulate NC programs on a PC 
based on the DIN 66025 programming language as well as the ShopMill, ShopTurn 
and language commands, type Sinumerik™ 828D and 840D sl. The programs 
generated with the software must only be used on machine tools for production if the 
software (SinuTrain/JobShop), on which the generated program should run, has 
been adapted to Sinumerik. 

This adaptation must be professionally performed by authorized personnel, e.g. by 
Siemens, by machine tool OEMs or by dealers; when carrying out any adaptation 
work, the specifications of Siemens and the machine tool OEM must always be 
carefully observed. Otherwise, the machine tool could malfunction.  

Otherwise, for customers in Germany, the "Allgemeinen Bedingungen zur 
Überlassung von Software für Automatisierungs- und Antriebstechnik an 
Lizenznehmer mit Sitz in Deutschland" applies for the software and for customers 
outside Germany "General License Conditions for Software Products for Automation 
and Drives for Customers with a Seat or Registered Office outside of Germany". 
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Technical Support 

If you have any technical questions, please contact our hotline: 
 Europe / Africa 
Phone +49 0911 895 7222 
Fax +49 0911 895 7223 
0.14 €/min from the German landline; cell phone charges may vary. 
Internet http://www.siemens.com/automation/support-request 

 

 Americas 
Phone +1 423 262 2522 
Fax +1 423 262 2200 
E-mail mailto:techsupport.sea@siemens.com 

 

 Asia / Pacific 
Phone +86 1064 757 575 
Fax +86 1064 747 474 
E-mail mailto:support.asia.automation@siemens.com 

 
 

Note 
Country-specific telephone numbers for technical support are provided under the 
following Internet address: 
http://www.automation.siemens.com/partner 
 

 

Questions about the manual 

If you have any queries (suggestions, corrections) in relation to this documentation, 
please fax or e-mail us: 
Fax +49 9131- 98 2176 
E-mail mailto:docu.motioncontrol@siemens.com 

Internet address 

http://www.cnc4you.siemens.com 



 

 Training and Programming 
52 6FC5095-0AC50-0YP0, 01/2013 

1   Introduction 
The training software SinuTrain for SINUMERIK Operate (called SinuTrain in the 
following) simulates a SINUMERIK 840D sl or SINUMERIK 828D with the 
SINUMERIK Operate user interface on your PC.  
 

Note 
License 
You require a license to use the machines in SinuTrain 
 

True to original representation and behavior 

As a result of the true to original representation of the operating panel front, machine 
control panel and user interface, SinuTrain facilitates real operation. 

● SinuTrain includes a machine control panel with specific functions of a real 
control panel (e.g. CYCLE START, operating mode etc.). 

● SinuTrain includes an operator panel, with which all of the specific functions of a 
real operator panel can be used (hotkey etc.). 

● The user interface corresponds to the original interface of SINUMERIK Operate. 

● The simulation behaves in precisely the same way as a real control. 

● The full functional scope of SINUMERIK Operate on SINUMERIK 840D sl / 828D 
is available. Exceptions are the following hardware-related functions and those 
that are not permitted: 
– Drive functions 
– V24 interface 
– Series commissioning 
– Remote diagnostics 
– Safety and PLC functionality 
– Ctrl-Energy 

● The scope of functions of the SINUMERIK 828D is additionally restricted by the 
following functions: 
– Service Planner 
– Easy Message 
– Easy Extend 
– Ladder Viewer and Ladder add-on 
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Saving and printing NC programs 

SinuTrain offers the option of saving the NC programs that you have created (G code 
and machining step programs). 

You also have the option of printing out a program which is opened in the user 
interface of SINUMERIK Operate. 

Add-On "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 

In order to extend the functionality of SinuTrain, the add-on (additional software 
component) "SinuTrain for SINUMERIK Operate Machine Configuration Tool" is 
available, which is installed together with SinuTrain.  

With the "SinuTrain for SINUMERIK Operate Machine Configuration Tool", you 
create a SinuTrain machine from a commissioning archive of a real machine – with 
which you can practice, learn and program just the same as at the real machine. 

You can find information about installing and operating "SinuTrain for SINUMERIK 
Operate Machine Configuration Tool" in the Chapter "Working with the machine 
configuration tool". 
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2   SinuTrain for SINUMERIK Operate 

2.1   Installing / uninstalling SinuTrain 

2.1.1   System requirements 
Hardware  

Processor: 1.5 GHz (singlecore) 

RAM: 1 GB 

Hard disk: 2 GB 

DVD drive: For installation using DVD data storage medium 

Graphic card: minimum resolution, 640x480 pixels 

USB interface 

Mouse, keyboard 

Operating systems 

● Windows XP (32 bit Professional, Home Edition) with Service Pack 3 

● Windows 7 (32-bit and 64-bit, Starter, Web Edition and Embedded are not 
supported) 

Software 

Adobe Acrobat Reader® 

2.1.2   Licensing using the Automation License Manager 
You require a valid license key to start a machine in SinuTrain. This is an integral 
part of SinuTrain for SINUMERIK Operate, and is supplied on a USB stick.  

A license is not required to use SinuTrain. 

Test license 

When setting up SinuTrain for the first time, a test license is also installed; this can 
only be activated once and expires 60 days after activation. The full functional scope 
is available for these 60 days. 
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License rules 

The following licenses are available with which respective machines can be 
operated: 

● SinuTrain for SINUMERIK Operate 
No restrictions of use from time and functional perspectives. 

● SinuTrain for SINUMERIK Operate Upgrade 
No restrictions of use from time and functional perspectives.  
Can be used in conjunction with a valid SinuTrain license. 

● SinuTrain for SINUMERIK Operate Student 
No restrictions of use from a functional perspective. 
License is only valid for a limited time. 

● SinuTrain for SINUMERIK Operate Trial 
No restrictions of use from a functional perspective. 
Test license is only valid for a limited time. 

The licenses allow the following machine configurations to be emulated: 

Single or multi-channel machines for any technology (turning, milling, universal) or 
828D BASIC machines for any technology (turning, milling) 

For all licenses, the expansion technology can be set as required. 
 

Transferring the license using the Automation License Manager  

Precondition: USB stick with the license to be transferred. 

1. Start the Automation License Manager via the icon or from the Start menu. 
The Automation License Manager opens. 

2. Insert the USB stick. 
"Removable Disk" appears below "Own Computer". 

3. Select the entry "Removable Disk" on the lefthand side. 
On the right-hand side you can see the available licenses on the USB stick. 

4. Transfer the license by dragging it and dropping it onto the local hard disk or use 
the righthand mouse key. 
- OR - 
In the shortcut menu, please select "Transfer... ". 

5. In the window that opens, select where the license should be transferred to 
(target). 
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After the license has been transferred, this is shown on the target drive. 
 

Note 
The test license only appears in the Automation License Manager once it has been 
activated.  
 

2.1.3   Installing SinuTrain 

Precondition 

You require a license key to start and work with machines that have been created. 
This must be transferred to the PC before starting a machine for the first time. When 
installing SinuTrain, an additional program is installed for this purpose – the 
Automation License Manager. The license key is transferred to the PC using the 
Automation License Manager.  
 

Note 
You cannot start any machine as long as there is no valid license. 
 

The SinuTrain for SINUMERIK Operate software product comprises various software 
components that in some cases have their own setup (e.g. Automation License 
Manager).  

General setup 

In a general setup, initially the Automation License Manager and SinuTrain are 
installed. The CAD reader is then optionally installed. 

Procedure 

1. Double-click the setup.exe in the root directory of the DVD. 
Under Windows 7, when the user account control is activated, after a double-click 
on setup.exe, initially a system prompt is issued. With this prompt, you agree that 
setup can make changes to your system; however, this prompt comes from 
Windows and is not a component created by Siemens. Confirm this dialog and 
proceed with the installation as described in the following points. 

2. Select the setup language and click on the "Next >" button. 

3. Read the notes and click on the "Next >" button. 

4. Read the product notes and click on the "Readme" button. 

5. Read the readme that opens, then close it and click on the "Next >" button. 

6. Select the languages in which you wish to install SinuTrain for SINUMERIK 
Operate . 
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The selected languages are available in SinuTrain as well as SINUMERIK 
Operate. 

7. Accept the license conditions as well as the security notes by activating the 
checkbox and then click on the "Next >" button. 

8. In the "Programs" window, activate the checkbox and click on the "Next>" button. 
If you wish to change the installation path of the individual products, select the 
specific product, click on the "Browse" button and select the required folder in the 
next window. 

 
 Note 

Before installing SinuTrain, under certain circumstances, system updates are 
automatically installed, which may make it necessary to restart the computer. 
Setup is automatically continued after the PC restarts. 

 

9. The installation of SinuTrain and Automation License Manager then starts. 
Once SinuTrain has been installed, you will receive the appropriate information 
and the prompt whether the computer should be restarted or not. 

10. Activate the "Yes, restart computer now" option if the computer is to be restarted 
and then click on the "Exit" button. 
The computer is restarted. The installation has then been completed. SinuTrain 
and Automation License Manager are ready. 

 

Note 
User account control for Windows 7 
When querying the user account control, if "unknown" is specified as the issuer and 
the upper part of the dialog is not dark blue-green, but orange-yellow, then respond 
with no and contact the hotline. All Siemens products released for Windows 7 have a 
certificate, where Siemens AG is always specified when querying the issuer. 
 

Note 
Click on the "Cancel" button to exit the installation. 
 

Note 
We recommend that the installation is not started from a network drive. This is 
because problems can be encountered as a result of possibly necessary system 
updates. 
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2.1.4   Uninstalling SinuTrain 
If the SinuTrain for SINUMERIK Operate product is uninstalled, then SinuTrain for 
SINUMERIK Operate Machine Configuration Tool is simultaneously uninstalled. 

Procedure 

1. In the Windows menu, select Start > Settings > Control Panel.  

2. Double-click in the list of the control panel on "Software" (Windows XP) or 
"Programs and functions" (Windows 7). 
The "Change or Remove Programs" button is active. 

3. In the software list, select "SinuTrain for SINUMERIK Operate 4.5" and click on 
the "Remove" button. 
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2.2   Operating SinuTrain 

2.2.1   This is how SinuTrain functions 

Precondition 

SinuTrain for SINUMERIK Operate has been installed.  

General sequence 

 
●  Start SinuTrain 

The machine list of SinuTrain opens. 

 

●  Creating a machine 
Create a machine in the machine list. 
To start, select a machine of the appropriate type using templates 
(Turning, Milling, Universal). 
Then define the designation, language and resolution of the 
SINUMERIK Operate user interface. 

 

●  Starting a machine 
The machine simulation opens with operator panel and user 
interface SINUMERIK Operate, machine control panel with feed 
and spindle override and CNC keyboard. 

 ●  Simulating a machine 
You can now operate the simulated machine just like a real 
machine and generate programs, for example. 
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2.2.2   Machine list 
In the machine list, you create machines - and parameterize and manage the 
machine configurations with which you train.     

 
1 SinuTrain menu  
2 Toolbar with symbols for important functions 
3 All of the machines that have been created are displayed. 
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 You obtain the following information in the list: 
● Machine 

Machine name, which you assigned when configuring in the "Settings" step 
under "General". 

● Description 
Brief description of the machine, which you enter during the configuration 
in the "Settings" step under "General". 

● Technology 
Indicates the type of machine, depending on the selected standard 
configuration: 
– 840D sl: Universal 
– 840D sl: Turning 
– 840D sl: Milling 
– 828D: Turning 
– 828D: Milling 

● License availability 
Shows the licensing state of the machine. Following license states are 
possible: 
– green check mark: a full license is available 
– red X: no valid license is available 
– yellow clock: a valid test license is available 
– black dash: the license status is unknown 

● Used the last time 
Specifies the time when the machine was shut down the last time.  

● Generated on 
Specifies the time when the machine configuration was originally created. 

 

See also 

Menu commands (Page 86) 

Overview of symbols for SinuTrain (Page 90) 

Status symbols for SinuTrain licenses (Page 91) 
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2.2.3   Screen layout of the machine simulation 

User interface of SinuTrain  

 
1 SinuTrain menu 
2 SINUMERIK Operate user interface 
3 Operator controls of an operator panel 
4 Machine control panel with feed and spindle override 
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2.2.4   Changing the SinuTrain language 
You have the option of changing over the language (German, English, French, 
Spanish, Italian, Chinese simplified) of the SinuTrain user interface. 

All of the languages installed when setting up or those subsequently installed using 
the Language Update Tool, can be selected. 

Procedure 
 ● Select the menu command Tools > Options > Language. 

 
 

Note 
Changing the language of SINUMERIK Operate 
In SINUMERIK Operate you can change the language of the SINUMERIK Operate 
user interface using the shortcut key <CTRL + L> or in the "Commissioning" 
operating area, using the "Change language" softkey.  
 

See also 

Installing additional languages for SINUMERIK Operate (Page 64) 

2.2.5   Changing the screen view 
Select between full screen and window view.   

Window view 

You have the option of moving, minimizing, maximizing and restoring the SinuTrain 
window. 

If the screen size is not large enough to display the component, then a lower and 
possibly a side scroll bar are displayed. 

Full screen 

Only SinuTrain for SINUMERIK Operate is visible on the screen.  

Procedure 
 ● Select the menu command View > Full screen. 
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2.2.6   Installing additional languages for SINUMERIK Operate 
You have the option of installing additional languages, e.g. missing standard 
languages or special languages for the SINUMERIK Operate user interface. 

Installing standard languages for SINUMERIK Operate 

If you install a standard language (English, French, Italian, Spanish, simplified 
Chinese), then the SinuTrain language is also installed. You then have access to the 
online help for SinuTrain for SINUMERIK Operate as well as the supplementary 
documentation in the respective language. 

Additional language packages 

Additional language packages can be downloaded from the following Internet 
address: 

http://www.cnc4you.siemens.com 

Procedure 
 1. Select the menu command Tools > Language Update Tool. 

The "Language Update Tool" window opens. 
 2. Click on the button "...", to open the path to archive the language 

packages. 
 3. Select the required language file (*.slf) and click on the "Open" 

button. 
You return to "Language Update Tool" window.  
The archive path is entered, the selected language is displayed 
and marked with a flag symbol. The software version of the 
SINUMERIK Operate language package is displayed. 

 4. Click on the "Install" button. 
A progress indicator indicates the installation process.  
You receive a message after successful installation. 

 5. Click on the "OK" button to complete the installation. 
 
 

Note 
After the note regarding successful installation, you have the option of disabling 
future installations of language packages. To do this, activate the checkbox "Do not 
display this note again". 
Reactivate this note for future installations using the menu command Tools > Options 
... > Notes.  
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2.3   Working with SinuTrain 

2.3.1   Starting and exiting SinuTrain 
  
Start SinuTrain 
 1. Select the menu command Programs > SinuTrain for SINUMERIK 

Operate 4.5 > SinuTrain. 
  - OR - 

 
 Double-click on the SinuTrain symbol on your desktop. 

 2. Select the language in which you wish to open SinuTrain for 
SINUMERIK Operate. 
Note: This selection window is only displayed when first starting 
SinuTrain. 

  SinuTrain for SINUMERIK Operate opens and displays a note 
regarding use. 

 3. Click on the "Start" button. 
The SinuTrain machine list opens. 

 
 

Note 
You have the option of deactivating the use note when SinuTrain starts in the future. 
To do this, activate the checkbox "Do not display this note again". 
Reactivate this note when starting the program in the future using the menu 
command Tools > Options ... > Note 
 
 

Exiting SinuTrain 
  Select the menu command File > Exit. 

SinuTrain closes. 
Note 
If you close SinuTrain with the machine running, then this is shut 
down in a controlled manner. 
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2.3.2   Starting and shutting down a machine. 

Precondition 

Machine configurations are available in the machine list. 

Starting a machine 
  The SinuTrain machine list is open. 
 1. In the selection list, select the required machine. 

 

2. In the toolbar, click on the "Start" symbol. 
- OR - 

  Select the menu command Machine > Start. 
The machine simulation with operator panel and user interface 
SINUMERIK Operate, machine control panel with feed and 
spindle override and CNC keyboard opens. 

 3. You operate SINUMERIK Operate using a mouse or a standard 
keyboard. 

 

4. When operating SINUMERIK Operate, click on the <HELP> key 
or press key <F12> to obtain context-sensitive online help for the 
Window and the input forms of SINUMERIK Operate. 
  

Shutting down the machine 
  Select the menu command Machine > Shut down, if you wish to 

exit the actual machine configuration.  
You return to the SinuTrain machine list. 

Restarting the machine 
  Select the menu command Machine > Restart, if you wish to 

restart the actual machine configuration - for instance, after 
changing machine data.  
The machine shuts down and is then immediately run up again. 
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2.3.3   Creating a machine 
A Wizard simplifies generating the required machine.   

You can see the status of the machine generation at a glance using the symbols in 
the wizards for the machine configuration.   
Symbol Significance 

 Machining step not yet executed 

 Currently pending machining step 

 Machining step completed 

 

Machine configuration 

You have the following options when creating a machine: 

● New machine from a template 
The standard configurations supplied for lathes and milling machines form the 
basis. 

● New machine from an existing machine configuration 
Basis is a machine configuration created by you which already exists in the 
SinuTrain machine list. 

● New machine from an imported machine configuration 
The basis is an exported machine configuration, which you import and modify. 

 

Creating a machine from a standard configuration 

 

1. Click on the "New" symbol. 

  - OR - 
  Select the menu command File > New.... 
  The "wizard for the machine configuration" dialog opens to select 

a task.  
The option field "Generate a new machine configuration from a 
template" is activated. 
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 2.  Click on the "Next >" button. 
 3. In the "wizard for the machine configuration", in the "Machine 

selection" field, select the machine version (e.g. simple vertical 
milling machine). 

 4. Click on the "Next >" button. 
 5. In the "Wizard for machine configuration", select the required 

settings (general, language and resolution) and enter the machine 
name and possibly a brief description, define the language and 
select the machine interface resolution.  

 6. Click on the "Finish" button. 
The newly created machine is inserted in the list of machine 
configurations. 
 

Creating a machine from an existing configuration 

 

1. Click on the "New" symbol. 

  - OR - 
  Select the menu command File > New.... 
 2. In the "Wizard for machine configuration", activate the option field 

"Generate new machine configuration from existing machine 
configuration". 

 3. Click on the "Next >" button. 
 4. In the "Wizard for machine configuration", in the "Machine 

selection" field, select the machine that you require and change 
the required settings (see "Generate machine from the standard 
configuration", steps 4 to 6). 
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Creating a machine from an imported configuration   
  Precondition: You have exported machine configurations as 

backup or as starting point for subsequent machine 
configurations. 

 

1. Click on the "Import" symbol. 

  - OR - 
  Select the menu item File -> Import. 
 2. In the "Wizard for machine configuration", the option field "Import 

a machine configuration" is activated. 
 3. Click on the "Next >" button. 
 4. Click on the button "...", to open the path to archive the exported 

configurations. 
 5. Select the required machine configuration file that has been 

exported (*.set) and click on the "Open" button. 
You return to the Wizards. The archiving path has been entered. 

 6. Click on the "Next >" button. 
 7. In the "wizard for the machine configuration", change the required 

settings and complete the configuration (see "Generate machine 
from standard configuration" steps 5 and 6). 

See also 

Exporting a machine configuration (Page 71) 
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2.3.4   Deleting a machine 
If you do not require a machine configuration any longer, you may delete it from the 
selection list of the SinuTrain machines.   

Procedure 
 1. Select the message that you wish to remove from the selection 

list. 

 

2. Click on the "Delete" symbol. 

  - OR - 
  Select the menu command File > Delete. 
 3. Confirm the note regarding the possible loss of data with "OK" 

and click in the subsequent prompt dialog box on the "Yes" button 
to delete the machine. 

 
 

Note 
SinuTrain machine with user data 
When deleting a machine, all user data (e.g. NC programs, work offsets etc.) are lost. 
The data associated with a deleted machine cannot be restored.  
 

Note 
You have the option of disabling the note regarding data loss for future delete 
operations. To do this, activate the checkbox "Do not display this note again". 
Reactivate this note for future delete operations using the menu command Tools> 
Options ... > Notes. 
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2.3.5   Exporting a machine configuration 
You have the option of exporting machines that you have configured in order to back 
them up. The exported machine configurations are available to you as a starting point 
for later machine configurations or as a back-up copy. To do this, import the saved 
machine configuration file.  

Exported machine configurations allow you to exchange these between two 
computers or to subsequently import them into more recent SinuTrain versions. 
 

Note 
The function "Export machine configuration" is not available for 828D BASIC 
machines. 
 

Procedure 
  The SinuTrain machine list is open, and you have configured 

machines according to your requirements. 

 

1. Click on the "Export" symbol. 

  - OR - 
  Select the menu item File -> Export. 
  The "wizard for the machine configuration" dialog opens to select 

a task. The option field "Exporting a machine configuration" has 
been activated. 

 2. Click on the "Next >" button. 
 3. In the "Wizard for machine configuration", in the "Machine 

selection" field, select the required machine and click on the "Next 
>" button.  

 4. In the "Wizard for machine configuration", click on the button "...". 
The "Save as" window opens. 

 5 Navigate to the archiving location required and click on "Save". 
 6. In the Wizard, click on the "Finish" button. 

A progress indicator indicates the export process.  
You receive a message after the operation has been successfully 
completed. 
The machine configuration file (*.set) is saved. The file can be 
reimported at any time. 
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Note 
For future machine export operations, you have the option of deactivating the note 
regarding the successful export. To do this, activate the checkbox "Do not display 
this note again". 
Reactivate this note for future export operations using the menu command Tools > 
Options... > Notes. 
 

See also 

Creating a machine (Page 67) 

2.3.6   Changing machine settings 
You have the option of changing the following settings for a machine settings:  

● General 
– Machine name 
– Description 

● Language 

Machine interface language (German, English, French, Spanish, Italian, simplified 
Chinese). Only those languages are available for selection that were also selected 
when installing the system. 

If you have a subsequently installed special languages using the Language Update 
Tool then these are also available for selection. 

● Resolution 
Resolution of the machine interface 
– 640x480 
– 800x600 
– 1024x768 
– 1280x1024 

 
 Note 

For 828D BASIC machines, only the resolution 640x480 of the machine interface 
is available. 

 

Procedure 
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 1. In the SinuTrain machine list, select the machine for which you 
wish to change the settings.  

 

2. Click on the "Settings" symbol. 

  - OR - 
  Select the menu command Machine > Settings... 
 3. In the lefthand selection window, select the required setting option 

and enter the new name or brief description, select the required 
language and/or define the size of the user interface of 
SINUMERIK Operate. 

 4. Click on "OK" to confirm your entries. 

2.3.7   Printing-out a program 
You have the option of printing out the contents of text files (for example, NC 
programs) using a printer configured at the PC (local printer, network printer) directly 
via SinuTrain from the SINUMERIK Operate user interface.  

You can print G code programs as well as ShopMill / ShopTurn machining step 
programs using G code. 

Page setup 

You can configure and define the print layout in the "Page setup" window; this 
defines the scope of the NC programs to be printed.  
 

Note 
The function "Print program" is not available for 828D BASIC machines. 
 
 

Settings Effect 
 
Left: 

 
Right: 

Margins 
(mm) 

Top: Bottom: 

Here you define the margins of the printout. 
Defines the distance between the upper, 
lower, righthand and lefthand side of the 
page and the particular edge of the lines in 
mm. 

   
Print 
area 

 
 
Everything 

Here you define the scope of the program 
printout. 
Defines that the complete NC program is 
printed. 
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Settings Effect 
Lines 
From: to:  

Defines the lines of the NC program that 
are to be printed. 

Selected range Defines that the part of the NC program 
selected in the editor is printed. 

  
Open blocks Defines that when using program blocks, 

the program sets in the blocks are also 
printed out. 

Printing cycles as G code Defines that sequence programs 
(ShopMill/ShopTurn) are printed out as G 
code. 

Procedure 

 

1. In the archive folder of the program manager, select the program 
that you wish to print out. 

 

2. Position the cursor on the program and click on the "Open" 
softkey. 
Program opens in the editor. 

 3. Select the menu command File > Page setup.  
 4. Enter the distances for the margins in the "Page setup" window, 

define the print range and the representation type of the program 
and click on the "OK" button to confirm your entries. 

 6. Select the menu command File > Print. 
The "Print" dialog box with the activated standard printer opens 
(local printer, network printer). 

 7. Click the "Print" button. 
Depending on the print range that has been defined, the complete 
program, a certain number of lines of the program or a selected 
range of the program is printed. 
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3   SinuTrain for SINUMERIK Operate 
Machine Configuration Tool 

3.1   Installing / uninstalling the Machine 
Configuration Tool 

3.1.1   Overview 
Using the SinuTrain for SINUMERIK Operate Machine Configuration Tool you create 
a SinuTrain machine from the commissioning archive of a real machine. This means 
that you have the opportunity of practicing, learning and programming at an image of 
a real, existing machine. 

You also have the option to parameterize transmission protection for exported 
SinuTrain for SINUMERIK Operate machine data. 
 

Note 
The parameter assignments taken from the commissioning archive are only valid for 
the machine configuration that has been created. 
 

Note 
Licensing 
You require a license to operate SinuTrain for SINUMERIK Machine Configuraion 
Tool . The tool cannot be started without this license. 
 

Transferring a license 

Together with SinuTrain for SINUMERIK Operate Machine Configuration Tool you 
receive a USB stick with the license to be transferred. 

The Automation License Manager is used to transfer the license. 

See also 

Licensing using the Automation License Manager (Page 54) 
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3.1.2   System preconditions 
Hardware  

Processor: 1.5 GHz (singlecore) 

RAM: 1 GB 

Hard disk: 2 GB 

DVD drive: For installation using DVD data storage medium 

Graphic card: minimum resolution, 640x480 pixels 

USB interface 

Mouse, keyboard 

Operating systems 

● Windows XP (32 bit Professional, Home Edition) with Service Pack 3 

● Windows 7 (32-bit and 64-bit, Editions Starter, Web Edition and Embedded are 
not supported) 

Software 

Adobe Acrobat Reader® 

SinuTrain for SINUMERIK Operate 

3.1.3   Installing the Machine Configuration Tool 

Preconditions 

You have purchased SinuTrain for SINUMERIK Operate Machine Configuration Tool.   

In order to use SinuTrain for SINUMERIK Operate Machine Configuration Tool, you 
must install SinuTrain for SINUMERIK Operate. 

 
 

Note 
For a successful installation, SinuTrain for SINUMERIK Operate and SinuTrain for 
SINUMERIK Operate Machine Configuration Tool must be the same version. 
SinuTrain for SINUMERIK Operate Machine Configuration Tool can only be installed, 
ifSinuTrain for SINUMERIK Operate has not been started. 
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Procedure 

1. Double-click the setup.exe in the root directory of the DVD. 

2. Select the setup language and click on the "Next >" button. 

3. Read the notes and click on the "Next >" button. 

4. Read the product notes and click on the "Readme" button. 

5. Read the readme that opens, then close it and click on the "Next >" button. 

6. Accept the conditions of the license agreement and click on the "Next >" button. 

7. The installation of SinuTrain for SINUMERIK Operate Machine Configuration Tool 
begins. 

8. You will receive the appropriate information once installation has been completed. 

9. Click on the "Finish" button. 

3.1.4   Uninstalling the Machine Configuration Tool 
The SinuTrain for SINUMERIK Operate Machine Configuration Tool can be 
separately uninstalled.  
 

Note 
SinuTrain for SINUMERIK Operate Machine Configuration Tool can only be 
uninstalled, ifSinuTrain for SINUMERIK Operate has not been started. 
If SinuTrain for SINUMERIK Operate is uninstalled, then the SinuTrain for 
SINUMERIK Operate Machine ConfigurationTool is also uninstalled. 
 

Procedure 

1. In the Windows menu, select Start > Settings > Control Panel. 

2. In the control panel list, double click on "Software". 

3. The "Change or Remove Programs" button is active. 

4. In the software list, select "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool 4.5" and click on the "Remove" button. 
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3.2   Using the Machine Configuration Tool 

3.2.1   So this is how the Machine Configuration Tool functions 

Precondition   

SinuTrain for SINUMERIK Operate Machine Configuration Tool is installed. 

General sequence - Generate a machine configuration from an archive file 

● Start SinuTrain 

● Call Machine Configuration Tool 

● Select an archive file 

● Make the general settings (name, language, resolution) 

● Set the transfer protection 

● Specify the archive directory 

General sequence - Subsequently apply transfer protection to exported machine 
configuration 

● Start SinuTrain 

● Call Machine Configuration Tool 

● Select the exported machine file 

● Define a password to start the machine 
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3.3   Working with the Machine Configuration Tool 

3.3.1   Creating a machine configuration 
A Wizard simplifies the process when creating the required machine configuration.  

You can see the status of the machine creation at a glance using the symbols in the 
wizards for the machine configuration. 
Symbol Significance 

 Machining step not yet executed 

 Currently pending machining step 

 Machining step completed 

Precondition 

A commissioning archive (*.arc) or a SinuTrain for SINUMERIK Operate machine file 
(*.set) is available. 
 

Note 
Other archive formats, such as e.g. data class archives (*.ard) are not supported. 
 

Procedure 

The wizard "SinuTrain for SINUMERIK Operate Machine Configuration Tool" opens 
with the step "Task selection". The option button "Machine configuration" is activated. 

1. Select Tools > Machine Configuration Tool. 
The wizard "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 
opens with the step "Task selection". 

2. Click on the "Next" button. 

3. Click in the wizard "SinuTrain for SINUMERIK Operate Machine Configuration 
Tool" with the step "Select archive" on the "..." button. 

4. In the "Open" window, via the selection list "Search in", select the storage location 
of the stored archive, select the required commissioning archive (*.arc) and click 
on the "Open" button. 

5. Then select the hardware platform (e.g. NCU720) on which the commissioning 
archive was created. 

6. Click on the "Next" button. 
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7. In the wizard "SinuTrain for SINUMERIK Operate Machine Configuration Tool", 
with the step "Settings", enter the required machine configuration data (name and 
description) as well as the resolution of the SINUMERIK Operate user interface. 

8. In the wizard "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 
with the step "Transfer protection" activate the checkbox "Suppress machine 
export" and/or "Password required for machine start" – and if required enter a 
password. 

9. Click on the "Next" button. 

10. In the wizard "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 
with the step "Archive Path" click on the "..." button. 

11. In the window "Save as", using the selection list "Save in", select the new 
machine configuration; if required, enter a new file name and click on the "Save" 
button. 

12. Click on the "Next" button. 
In the wizard "SinuTrain for SINUMERIK Operate Machine Configuration Tool" 
you will obtain a summary of all of the important settings of the machine 
configuration to be created. 

13. Click on the "Finish" button. 
You will receive a message that the machine configuration was successfully 
generated.  
Click on "OK" to complete the operation. 

 

Note 
If this note regarding the successful creation of the machine configuration should no 
longer be displayed in the future, then activate the checkbox "Do not display this note 
again". 
Reactivate this note for future machine configurations using the menu command 
Tools > Options... > Configuration Tool . 
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3.3.2   Assigning transfer protection to exported machines. 
You have the option of subsequently assigning transfer protection to exported 
machines.  

You must enter the required password in order to start a machine – assigned transfer 
protection - in the machine list. 
 

Note 
Exported machine files, which were created with a previous version of SinuTrain for 
SINUMERIK Operate , cannot be assigned transfer protection. 
 

Precondition 

A SinuTrain for SINUMERIK Operate machine file (*.set) is available. 

Procedure 
 1. Select Tools > Machine Configuration Tool. 

The wizard "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" opens with the step "Task selection". 

 2. Activate the option "Add transfer protection" and click on the 
"Next" button. 

 3. Click in the wizard "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" with the step "Machine selection" on the "..." 
button. 

 4. In the "Open" window, via the selection list "Search in", select the 
storage location of the exported machines, select the required 
machine file (*.set) and click on the "Open" button. 

 5. Click on the "Next" button. 
 6. In the wizard "SinuTrain for SINUMERIK Operate Machine 

Configuration Tool" with the step "Transfer protection", activate 
the checkbox "Password required for machine start". 
The input fields "Password" and "Repeat password" can be 
edited. 

 7. Enter the required password in both fields and click on the 
"Finish" button. 
You will then receive a message that the transfer protection has 
been successfully set. 

 8. Click on "OK" to complete the operation. 
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Note 
If the note stating that transfer protection has been successfully set should no longer 
be displayed in the future, then activate the checkbox "Do not display this note 
again". 
Reactivate this note for future settings of a transfer protection using the menu 
command Tools > Options... > Configuration Tool . 
 

3.3.3   Removing the transfer protection 
You have the option of partially removing transfer protection  
 

Note 
Starting password 
You cannot subsequently change a starting password that has been assigned. 
 

Precondition 

A SinuTrain for SINUMERIK Operate machine file (*.set) has transfer protection. 

Procedure 
 1. Select Tools > Machine Configuration Tool. 

The wizard "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" opens with the step "Task selection". 

 2. Activate the option "Edit transfer protection" and click on the 
"Next" button. 

 3. Click in the wizard "SinuTrain for SINUMERIK Operate Machine 
Configuration Tool" with the step "Machine selection" on the "..." 
button. 

 4. In the "Open" window, via the selection list "Search in", select the 
storage location of the exported machines, select the required 
machine file (*.set) and click on the "Open" button. 

 5. Click on the "Next" button. 
 6. In the wizard "SinuTrain for SINUMERIK Operate Machine 

Configuration Tool" with the step "Transfer protection", deactivate 
the checkbox "Suppress machine export". 

 7. Click on the "Finish" button. 
You will then receive a message that the transfer protection has 
been successfully removed. 

 8. Click on "OK" to complete the operation. 
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Note 
If the note stating that transfer protection has been successfully set should no longer 
be displayed in the future, then activate the checkbox "Do not display this note 
again". 
Reactivate this note for future settings of a transfer protection using the menu 
command Tools > Options... > Configuration Tool . 
 



 

 Training and Programming 
84 6FC5095-0AC50-0YP0, 01/2013 

4   Additional documentation 

4.1   Operating Manual and training instructions 
When using SinuTrain, you have the option of using the context-sensitive online help 
of SINUMERIK Operate via the HELP key.  

Furthermore, additional and more in depth operating manuals and training 
documents are available in six languages (German, English, French, Italian, Spanish, 
simplified Chinese). 
 

Note 
If a particular foreign language version of a document is not available, then as an 
alternative, the English edition is available. 
 

Operating Manuals and Training Documents 

● Easy milling with ShopMill 
– Milling basics 
– Handling the program 
– Step-by-step instructions for programming and machining various examples 

● Turning made easy with ShopTurn 
– Turning basics 
– Handling the program 
– Step-by-step instructions for programming and machining various examples 

● Milling 
– Detailed operating manual for SINUMERIK Operate on SINUMERIK 840D 

sl/828D, milling version. 

● Turning 
– Detailed operating manual for SINUMERIK Operate on SINUMERIK 840D 

sl/828D, turning version. 

● Universal 
– Detailed Operating Manual for SINUMERIK Operate on SINUMERIK 840D sl, 

Universal version (without cycles description). 

● Basic Functions 
– Detailed Function Manual with a description of basic SINUMERIK functions. 

● G code programming 
– Detailed Programming Manual with a description of all parameters. 
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● Programming Manual, Fundamentals 
– Programming Manual for users with a basic knowledge about drilling, milling 

and turning. 
– Simple programming examples that also explain commands and operations 

according to DIN 66025. 

● Function Manual ISO Dialects 
– Description for the commissioning and execution option of part programs 

belonging to external CNC systems. 

● Programming Manual, ISO milling 
– Detailed description of the special issues when programming in the ISO 

mode, milling version. 
Programming Manual, ISO turning 
– Detailed description of the special issues when programming in the ISO 

mode, turning version. 

● CAD Reader 
– Handling the program 
– Instructions using an application example 
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A Appendix 

A.1 Menu commands 
The following menu commands are available to operate SinuTrain:  

 
 
Menu Menu commands Function 

New... Starts the wizard for the machine 
configuration. 

Deleting Deletes a selected SinuTrain 
machine. 

Import... Opens the "Wizard for the machine 
configuration" to include stored and 
backed up machines in the 
SinuTrain machine list. 

File 

Export... Opens the "Wizard for the machine 
configuration", to export machine 
configurations from the SinuTrain 
machine list. 

 Page setup... Opens the "Page setup" window. 
Here you define the margins and 
print range and select the 
representation type of the NC 
programs. 

 Print  Prints programs corresponding to 
what has been defined in "Page 
setup" from the SINUMERIK 
Operate editor.  

 Exit Exits SinuTrain for SINUMERIK 
Operate. 

View Full screen  Here you select between a window 
view and full screen view. 
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Menu Menu commands Function 
Machine Start Starts the machine configuration 

selected in the selection box of the 
SinuTrain machine list. 

 Restart The SinuTrain machine is 
automatically shut down and then 
automatically restarted. 

 Shutting down Shuts down the SinuTrain machine.  
The SinuTrain machine list remains 
open. 

 Settings… Opens the window "Settings", in 
which you can set the language 
and resolution of the SINUMERIK 
Operate user interface. 

 Check license availability Checks whether an adequate 
license is available for the selected 
SinuTrain machine. 

 License information... Shows which licenses can be used 
for the selected machine. 

Options Language Update Tool Calls the Language Update Tool . 
 Machine Configuration Tool Calls the SinuTrain for SINUMERIK 

Operate Machine Configuration 
Tool. 
The menu entry is only listed, if the 
add-on SinuTrain for SINUMERIK 
Operate Machine Configuration 
Tool has been installed. 

 Check license availabilities Checks the license availability for 
all of the machine configurations 
included in the machine list. 

Language Here you have the option of 
changing the language of the 
SinuTrain user interface. 

 Options... 

Notes Activates or deactivates messages 
in SinuTrain for SINUMERIK 
Operate (e.g. note regarding a 
possible data loss when deleting a 
SinuTrain machine). 
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Menu Menu commands Function 
Help topics Opens the online help for SinuTrain 

for SINUMERIK Operate. 
Tools Machine 

Configuration 
Tool 

Opens the online help for SinuTrain 
for SINUMERIK Operate Machine 
Configuration Tool.  
The menu entry is only available if 
the SinuTrain for SINUMERIK 
Operate Machine Configuration 
Tool has been installed. 

Help 

Info... Opens the information window 
"About SinuTrain for SINUMERIK 
Operate". 
This will tell you the product version 
of the installed SinuTrain for 
SINUMERIK Operate. 
The "Installed tools" area contains 
the versions of all of the installed 
add-on components (e.g. SinuTrain 
for SINUMERIK Operate Machine 
Configuraion Tool). 
The "Extended... " button opens a 
dialog with an overview of all 
installed component versions. 
By pressing the "Copy" button, you 
can copy all of the version 
information into the clipboard, for 
example to attach this to a mail 
when clarifying a problem.  
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A.2 Context menu 
In the machine list there is a context menu with the following commands: 
Menu commands  Function 
Start Starts the machine configuration selected in the selection 

box of the SinuTrain machine list. 
Export... Opens the "Wizard for the machine configuration", to 

export machine configurations from the SinuTrain machine 
list. 

Deleting Deletes a selected SinuTrain machine. 
Settings… Opens the window "Settings", in which you can set the 

language and resolution of the SINUMERIK Operate user 
interface. 

Check license 
availability 

Checks whether an adequate license is available for the 
selected SinuTrain machine. 

License information... Shows which licenses can be used for the selected 
machine. 
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A.3 Overview of symbols for SinuTrain 
The following symbols are available in the SinuTrain machine list toolbar to quickly 
select important functions.   
Symbol Significance 

 

Start 
Starts the machine selected from the list. 

 

Import 
Opens the window of the Wizards for the machine configuration, 
with which you can import a configuration that has already been 
created. 

 

Export 
Opens the window of the Wizard for the machine configuration, 
with which you can export a configuration that has been 
created. 

 

New 
Opens the window for the machine configuration. 

 

Deleting 
Deletes a selected machine configuration. 

 

Settings 
Opens the "Settings" windows in which you can enter the 
settings for language and resolution of the SINUMERIK Operate 
user interface. 
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A.4 Status symbols for SinuTrain licenses 
The following symbols provide information about the availability or the validity of 
licenses of the machines.    
Status symbol Significance  

 
Valid license is available 

 
No valid license is available 

 A valid test license is available 

 
Status of the license is not known 
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A.5 Operation with standard PC keyboard 
The following keys and key combinations are available for operation of SinuTrain 
SINUMERIK Operate.  
PC keyboard Function 
<F1> ... <F8> Horizontal softkeys 1 to 8 
Shift + <F1> ... <F8> Vertical softkeys 1 to 8 
<F9> 

 

Shift + <F9> 

 

<F10> 

 

Shift + <F10> 

 

<F11> 

 

<F12> 

 

<Page↑> 

 

<Page↓> 

 

<Enter> 

 

<Insert> 
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PC keyboard Function 
Numerical block <5> 

 

<Esc> 

 

<Ctrl> + <Alt> + <Shift> + <1>

 

<Ctrl> + <Alt> + <Shift> + <2> The operational SinuTrain machine is run down. 
<Ctrl> + <Alt> + <Shift> + <3>

 

<Ctrl> + <Alt> + <Shift> + <4>

 

<Ctrl> + <Alt> + <Shift> + <5>

 

<Ctrl> + <Alt> + <Shift> + <6>

 

<Ctrl> + <Alt> + <Shift> + <7>

 

<Ctrl> + <Alt> + <Shift> + <8>
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